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KATA PENGANTAR 

Puji dan syukur selayaknya penulis panjatkan ke hadlirat Illahi Rabbi 

karena berkat Rahmat dan Hidayah-Nya pula akhirnya Modul kursus desain grafis 

bermotif batik daring dengan judul : Prinsip Desain Grafis diselesaikan sesuai 

rencana.  

Penyusunan Modul kursus bertujuan sebagai tuntunan atau acuan untuk 

mempermudah instruktur  atau pihak lain yang akan menyelenggarakan kursus 

desain grafis bermotif batik daring dalam memfasilitasi dan menyajikan materi 

tersebut di daerah peserta kursus masing-masing. 

Kami menyadari bahwa penyusunan Modul kursus ini masih jauh dari 

kesempurnaan, dikarenakan keterbatasan pengetahuan dan bahasa, oleh karena 

itu diperlukan masukan untuk perbaikan dan penyempurnaan Modul sejenis di 

masa yang akan datang. 

Kepada semua yang terlibat dalam penyusunan diucapkan terimakasih 

semoga Allah SWT, membalas amal kebaikannya. 

 Akhir kata semoga Modul ini dapat digunakan dan bermanfaat bagi 

pelaksanaan pembelajaran kursus desain grafis bermotif batik daring di manapun 

kegiatan tersebut diselenggarakan.  

Bandung Barat, November 2019 
Kepala, 

Dr. Drs. H. Bambang Winarji, M.Pd. 
NIP 196101261988031001
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PETUNJUK PENGGUNAAN 

 

Modul ini disusun dengan tujuan untuk  memberikan pembekalan 

pengetahuan kepada peserta didik dalam melaksanakan pembelajaran pada 

program Kursus Desaian Grafis Bermotif Batik Dalam Jaringan, yang di Lembaga 

Kursus dan Pelatihan (LKP). 

Modul ini terdiri dari 7 (tujuh) seri,  yang meliputi judul: 1) Prinsip Desain 

Grafis, 2) Aplikasi Program Corel Draw untuk Desain Grafis, 3) Aplikasi Program 

Photoshop untuk Desain Grafis, 4) Pencetakan dan Sablon, 5) HaKI (Hak Atas 

Kekayaan Intelektual) dan K3 (Keselamatan dan Kesehatan Kerja), 6) 

Kewirausahaan dan Industri Desain Grafis, 7) Motif Batik.  

Modul seri ke- 1 berjudul  Prinsip Desain Grafis, berisi tentang prinsip 

dasar desain grafis. Dengan memahami bahan ajar ini peserta didik diharapkan 

memahami pengertian, karakteristik, unsur-unsur yang perlu diperhatikan, dan 

prinsip dasar desain grafis. 

Modul seri ke- 2 berjudul  Aplikasi Program Corel Draw untuk Desain 

Grafis berisi tentang pengertian, langkah memulai, dan menggunakan aplikasi 

program corel draw. Dengan memahami bahan ajar ini peserta didik diharapkan 

memahami cara aplikasi pengolah teks, gambar dan efek-efek tertentu untuk 

memperindah suatu objek.   

Modul seri ke- 3 berjudul  Aplikasi Program Photoshop untuk Desain 

Grafis, berisi tentang konsep photoshop, memulai penggunaan photoshop dan 

menyunting image dengan photoshop. Dengan memahami bahan ajar ini peserta 

didik diharapkan memahami cara aplikasi pengolah teks, gambar dan efek-efek 

tertentu untuk memperindah suatu objek dengan aplikasi program photoshop.  

Modul seri ke- 4 berjudul  Pencetakan dan Sablon, berisi tentang konsep, 

jenis dan teknik pencetakan dan sablon. Dengan memahami bahan ajar ini 

peserta didik diharapkan memahami berbagai teknik pencetakan dan sablon.  
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Modul seri ke- 5 berjudul  HaKI (Hak Atas Kekayaan Intelektual) dan K3 

(Keselamatan dan Kesehatan Kerja, berisi tentang pengertian, sejarah, prinsip, 

macam, dan manfaat HaKi dan K3. Dengan mema 

hami bahan ajar ini peserta didik diharapkan memahami  dan 

mengimlementasikan HaKi dan K3. 

Modul seri ke-6 berjudul  Kewirasahaan dan Industri Kreatif Desain 

Grafis, berisi tentang  pengetian, etika, tujuan dan sikap yang perlu dimiliki 

seorang wirausaha. Dengan memahami bahan ajar ini peserta didik diharapkan 

memahami etika dan sikap yang  perlu dimiliki seorang wirausaha agar berhasil 

dalam usahanya.  

Modul seri ke- 7 berjudul  Motif Batik, berisi tentang  pengertian, jenis, 

alat, bahan, proses, motif batik dan filosofinya. Dengan memahami bahan ajar ini 

peserta didik diharapkan memahami dan mampu mendesain berbagai motif 

batik dengan filosofinya.  

Setiap Seri dari Judul Modul ini disertai latihan dan test formatif untuk 

memudahkan peserta didik memahami seluruh materi Kursus Desaian Grafis 

Bermotif Batik Dalam Jaringan. 

Untuk memahami Modul ini, langkah-langkah yang Anda lakukan sebagai 

berikut: 

1. Sebelum kegiatan pembelajaran dilakukan, sebaiknya anda download semua 

materi HAKI dan K3 ini  

2. Pelajari dan pahamilah secara mendalam tujuan yang harus dicapai dari 

setiap kegiatan belajar 

3. Carilah sumber atau bacaan lain yang relevan untuk menunjang pemahaman 

dan wawasan Anda tentang materi ini  

4. Apabila ada bagian yang kurang dipahami, buatlah catatan untuk bahan 

konsultasi kepada instruktur saat kegiatan kursus tatap muka (luring) 

5. Jika ada kesulitan pada saat daring, dapat dilakukan konsultasi dengan  

instruktur materi tersebut melalui forum diskusi, chat, atau email.  
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6. Kerjakanlah latihan pada setiap kegiatan belajar tersebut untuk mengukur 

pemahaman Anda  

7. Kerjakan tugas yang diberikan pada setiap modul dengan cara mendownload 

tugas tersebut, kemudian menguploadnya jika sudah selesai dikerjakan  

8. Jika anda sudah menyelesaikan kegiatan kursus tatap muka (luring) dan 

online (daring atau dalam jaringan) dengan tuntas, selanjutnya Anda dapat 

memilih materi ini untuk pelaksanaan tugas mandiri. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
Modul Desain Grafis Level III KKNI      1 
 

 

 

Pendahuluan 

Di era modern seperti sekarang ini, hampir semua hal yang seringkali kita lihat untuk 

menyampaikan informasi sudah berbentuk visual atau digital. Dan semua itu tidak terlepas 

dari yang namanya Graphic Design atau Desain Grafis. Desain grafis sekarang ini telah 

dijadikan sebagai solusi yang terbaik untuk digunakan dalam membuat berbagai macam hal 

yang bersifat visual communication. Seperti saja contoh kecilnya adalah poster yang mana 

sekarang ini sudah banyak dibuat menggunakan desain grafis secara digital. 

Tak hanya poster, bahkan foto dan juga lukisan sekarang ini sudah banyak dikembangkan 

atau disempurnakan dengan adanya desain grafis sehingga membuat foto dan juga lukisan 

atau gambar menjadi terlihat lebih menarik berkat olahan melalui desain grafis tersebut. 

Dalam modul ini akan dibahas mengenai prinsip dasar di dalam desain grafis dimana dalam 

pembahasannya mengacu kepada Standar Kompetensi Kerja Nasional Indonseia (SKKNI) dan 

Kerangka Kualifikasi Nasional Indonesia ( KKNI). Modul ini diharpakan menjadi salah-satu 

bahan referensi untuk para instruktur baik pemerintah maupun swasta dalam mengajarkan 

mengenai prinsip dasar desain grafis sesuai dengan standar yang telah ditetapkan. Berikut 

adalah Standar Kompetensi Desain Grafis yang telah di rangkum dalam skema uji 

kompetensi. 

 

No Kode Unit Judul Unit 

1 M.74100.001.02 Mengaplikasikan Prinsip Dasar Desain 

2 M.74100.002.02 Menerapkan Prinsip Dasar Komunikasi 

3 M.74100.005.02 Menerapkan Design Brief 

4 M.74100.009.02 Mengoperasikan Perangkat Lunak Desain 

5 M.74100.010.01 Menciptakan Karya Desain 
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DAFTAR ISI  

 

 

PENDAHULUAN 

DAFTAR ISI 

DESAIN GRAFIS 

UNSUR – UNSUR & PRINSIP DASAR DESAIN GRAFIS 

WARNA 

TIPOGRAFI 

MENGOPERASIKAN PIRANTI LUNAK DESAIN GRAFIS 

MENCIPTAKAN KARYA DESAIN 

FINAL ARTWORK 
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Desain Grafis 

 

Tujuan Pembelajaran : 

Setelah mempelajari bab 2 ini diharapkan peserta didik mampu : 

1. Mengetahui Pengertian desain grafis 

2. Mengetahui sejarah desain grafis 

3. Mengetahui Fungsi desain grafis 

 

A. Pengertian Desain Grafis 

Sebelum membahas lebih jauh mengenai hal-hal yang menyangkut tentang desain 

grafis, ada baiknya kita mengetahui terlebih dahulu tentang apa yang dimaksud dengan 

desain grafis. Desain Grafis berasal dari 2 buah kata yaitu Desain dan Grafis. Kata desain 

sendiri memiliki arti yaitu sebuah proses atau perbuatan dengan mengatur segala 

sesuatu sebelum bertindak atau merancang. Sedangkan grafis sendiri memiliki arti yaitu 

titik atau garis yang berhubungan dengan cetak mencetak. Jadi dengan pengertian yang 

sudah dituturkan di atas tadi, dapat diartikan bahwa desain grafis adalah kombinasi 

kompleks antara kata-kata, gambar, angka, grafik, foto dan ilustrasi yang membutuhkan 

pemikiran khusus dari seorang individu yang bisa menggabungkan elemen-elemen ini, 

sehingga mereka dapat menghasilkan sesuatu yang khusus atau sangat berguna dalam 

bidang gambar. Ilmu desain grafis mencakup seni visual, tipografi, tata letak dan desain 

interaksi. 

 

Desain grafis pada awalnya diterapkan untuk media-media statis, seperti buku, majalah, 

dan brosur. Sebagai tambahan, sejalan dengan perkembangan zaman, desain grafis juga 

diterapkan dalam media elektronik, yang sering kali disebut sebagai desain interaktif 

atau desain multimedia. Batas dimensi pun telah berubah seiring perkembangan 

pemikiran tentang desain. Desain grafis bisa diterapkan menjadi sebuah desain 

lingkungan yang mencakup pengolahan ruang. 
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Saat ini, desain grafis lebih dikenal dengan “Desain Komunikasi Visual” atau biasa 

disingkat dengan sebutan DKV. Disebut seperti itu karena peran desain grafis dalam 

mengkomunikasikan pesan dan informasi kepada audiens dengan cara sentuhan visual 

yang sangat kental, seperti: warna, ilustrasi, tipografi, garis dan sebagainya. Bahkan, 

desain grafis sering dikategorikan sebagai commercial art karena merupakan paduan 

antara seni rupa dengan komunikasi untuk tujuan bisnis. 

B. Sejarah Desain Grafis 

Awal mula perjalanan sejarah mengenai desain grafis dapat ditelusuri melalui jejak 

peninggalan manusia dalam bentuk lambang-lambang grafis (sign & simbol) yang 

berwujud gambar (pictograf) atau tulisan (ideograf). Gambar mendahului tulisan karena 

gambar dianggap lebih bersifat langsung dan ekspresif, dengan dasar acuan alam (flora, 

fauna,landscape dan lain-lain). Bangsa mesir termasuk salah satu masyarakat yang 

pertama kali menciptakan media bentuk tulisan menggunakan gambar-gambar yang 

lebih dikenal Huruf Hieroglyphe. Mereka menggunakan gambar-gambar tersebut unutk 

menceritakan peristiwa besar yang terjadi pada jaman mereka. 

 

Tulisan/aksara merupakan hasil konversi gambar, bentuk dan tata aturan komunikasinya 

lebih kompleks dibandingkan gambar. Belum ada yang tahu pasti sejak kapan manusia 

memulai menggunakan gambar sebagai media komunikasi. Manusia primitif sudah 

menggunakan coretan gambar di dinding gua untuk kegiatan berburu binatang. 

Contohnya seperti yang ditemukan di dinding gua Lascaux, Perancis. 

Desain grafis sebagai media komunikasi sudah dikenal sejak masa prasejarah dan hampir 

setua peradaban manusia. Hal ini dapat dilihat pada jaman paleo-lithicum di gua lascaux, 

Prancis selatan, yang banyak ditemukan gambar-gambar binatang dan manusia pra 

sejarah. Gambar pada dinding tersebut memang tidak dibuat untuk tujuan seni, tetapi 

lebih sebagai komunikasi visual untuk tujuan ritual dan praktis demi kelangsungan hidup 

mereka. Meski demikian, pada saat manusia prasejarah memilih media, menentukan 

awal goresan, dan memperhitungkan ukuran gambar, sebenarnya mereka telah 

mendesain. 
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Lambang/aksara sebagai alat komunikasi diawali oleh bangsa Punesia (+ 1000 tahun 

SM), yang saat itu menggunakan bentuk 22 huruf. Kemudian disempurnakan oleh 

bangsa Yunani (+ 400 tahun SM) antara lain dengan mengubah 5 huruf menjadi huruf 

hidup. Kejayaan kerajaan Romawi di abad pertama yang berhasil menaklukkan Yunani, 

membawa peradaban baru dalam sejarah Barat dengan diadaptasikannya 

kesusasteraan, kesenian, agama, serta alfabet Latin yang dibawa dari Yunani. Pada 

awalnya bangsa Romawi menetapkan alfabet dari Yunani tersebut menjadi 21 huruf : A, 

B, C, D, E, F, G, H, I, K, L, M, N, O, P, Q, R, S, T, V, dan X, kemudian huruf Y dan Z 

ditambahkan dalam alfabet Latin untuk mengakomodasi kata yang berasal dari bahasa 

Yunani. Tiga huruf tambahan J, U dan W dimasukkan pada abad pertengahan sehingga 

jumlah keseluruhan alfabet Latin menjadi 26. 

Ketika perguruan tinggi pertama kali berdiri di Eropa pada awal milenium kedua, buku 

menjadi sebuah tuntutan kebutuhan yang sangat tinggi. Teknologi cetak belum 

ditemukan pada masa itu, sehingga sebuah buku harus disalin dengan tangan. Konon 

untuk penyalinan sebuah buku dapat memakan waktu berbulan-bulan. Guna memenuhi 

tuntutan kebutuhan penyalinan berbagai buku yang semakin meningkat serta untuk 

mempercepat kerja para penyalin (scribes), maka lahirlah huruf Blackletter Script, 

berupa huruf kecil yang dibuat dengan bentuk tipis-tebal dan ramping. Efisiensi dapat 

terpenuhi lewat bentuk huruf ini karena ketipis-tebalannya dapat mempercepat kerja 

penulisan. Disamping itu, dengan keuntungan bentuk yang indah dan ramping, huruf-

huruf tersebut dapat dituliskan dalam jumlah yang lebih banyak diatas satu halaman 

buku. 

Perkembangan proses cetak mencetak dimulai pada abad ke-15 dengan ditemukannya 

mesin alat cetak oleh Johanes Gutenberg (1398-1468) di jerman. pada tahun 1455 di 

Mainz Jerman, untuk pertama kalinya hasil cetakan yang dibuat adalah 42 baris kalimat 

yang diambil dari Bible menggunakan jenis font Texture Blackletter. Pada perkembangan 

berikutnya, Aloys Senefelder (1771-1834) menemukan tehnik cetak Lithografi. berbeda 

dengan mesin cetak Gutenberg yang memanfaatkan tehnik cetak tinggi. Tehnik cetak 

Lithografi menggunakan tehnik cetak datar yang memanfaatkan prinsip saling tolak 

antara minyak dan air. Tehnik ini memungkin kan melakukan penggambaran secara lebih 
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leluasa dalam bentuk blok-blok serta ukuran besar, juga memungkinkan dilakukannya 

pemisahan warna. Pada masa inilah seni poster mulai berkembang dengan pesat. Masa 

keemasan ini disebut sebagai The Golden Age of The Poster. 

C. Fungsi Desain Grafis 

A. Sebagai media komunikasi 

Ternyata fungsi desain grafis cukup penting sebagai media komunikasi. Hasil karya 

dalam membuat desain grafis bisa digunakan sebagai media komunikasi. Seperti 

contohnya digunakan untuk membuat banner, slogan, atau gambar dan tulisan sebagai 

informasi. Membuat banner atau slogan tentu lebih menarik jika dibuat dengan gambar 

dibanding hanya tulisan. Sehingga orang akan mudah memahami informasi tersebut. 

B. Sebagai media promosi 

Selain sebagai media komunikasi, fungsi desain grafis adalah untuk promosi. Kini banyak 

perusahaan yang menggunakan desain grafis untuk mempromosikan produk komersil 

mereka. Mereka akan membuat iklan dalam bentuk gambar bergerak maupun tidak. 

Iklan tersebut dibuat sedemikian rupa hingga konsumen tertarik pada produk mereka. 

C. Media apresiasi seni  

Desain grafis juga menjadi media untuk apresiasi seni. Hal ini dikarenakan pembuatan 

desain grafis menggunakan seni. Para desainer grafis tentu juga membutuhkan daya 

kreatifitas dalam membuatnya. Untuk lebih mengapresiasi seni dan kreatifitas, saat ini 

sudah banyak digelar ajang perlombaan desain grafis. Sehingga bisa menampilkan para 

generasi desainer grafis yang kreatif. 

D. Menyalurkan hobi dan mendapat penghasilan 

Bagi pecinta oleh gambar, desain grafis dapat digunakan untuk menyalurkan hobi. Tidak 

hanya itu, membuat desain grafis juga bisa mendapat penghasilan. Hal ini disebabkan 

kebutuhan akan desain grafis semakin meningkat. Banyak kebutuhan komersial yang 

menggunakan desain grafis. 
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E. Menambah keindahan 

Adanya desain grafis dapat menambah keindahan pada sebuah gambar. Dahulu sebelum 

ada desain grafis, gambar yang dihasilkan lebih monoton. Jika ingin membuat gambar 

dengan tingkat yang lebih sulit dibutuhkan waktu yang lama. Dengan membuat desain 

grafis, gambar akan terlihat lebih bagus. 
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Tujuan Pembelajaran : 

Setelah mempelajari bab 2 ini diharapkan peserta didik mampu : 

1. Mengetahui Unsur-unsur desain grafis 

2. Membuat ilustrasi dengan menggunakan unsur desain grafis 

3. Mengetahui Prinspid dasar desain grafis 

4. Menerapkan Prinsip desain grafis 

 

 

Unsur – Unsur & Prinsip Dasar  
Desain Grafis 

 

 

 

 

 

 

 

1. Unsur- Unsur dalam Desain Grafis  

Sebagai seorang desainer grafis peralatan utama yang harus dimiliki adalah sebuah ide serta 

kemampuan untuk menuangkan pikiranya kedalam seni grafis, seorang desainer grafis yang 

handal tentu ingin memaksimalkan sebuah kaya seni yang dihasilkan. untuk menunjang 

sempurnanya desain yang dihasilkan ada beberapa unsur yang harus dipelajari. 

Semua unsur tersebut tidak harus dikombinasikan secara bersamaan dalam satu desain, 

seringkali salah satu unsur mendominasi pengerjaan sebuah desain, tergantung bagaimana 

hasil yang diinginkan, kadangkala ada sebagian desain yang menuntut salah satu dari unsur 

tersebut harus diprioritaskan, jadi ada penekanan-penekanan dalam setiap unsur. Berikut 

merupakan unsur-unsur desain grafis dan prinsipnya: 

1. Titik 

Titik adalah unsur paling dasar dalam seni rupa dan desain, semua karya seni berasal dari 

titik. misalnya garis yang terbentuk dari kumpulan titik yang sangat padat. titik juga 

digunakan untuk memberikan lokasi antara titik satu dengan lainnya, contohnya ketika 

membentuk segitiga yang memiliki 3 titik lalu dibuatlah garis untuk membentuk segitiga itu 

sendiri. 
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Ilustrasi diatas memperlihatkan bahwa titik bisa padukan sehingga membentuk berbagai 

macam karya seni.  

2. Garis (Line) 

Sebuah garis adalah unsur desain yang menghubungkan antara satu titik poin dengan titik 

poin yang lainnya. Garis dapat diartikan sebagai goresan pensil, pena, atau mouse dalam 

komputer dan lain sebagainya. Garis tidak mengenal istilah kedalaman (depth), dan hanya 

memiliki ketebalan dan panjang, oleh sebab itu garis sering dimaknai sebagai elemen satu 

dimensi. Bentuk garis memiliki banyak variasi, bentuk garis itu sendiri biasanya dapat 

memaknai penggunaanya. contoh penggunaan garis misalnya: 

1. Garis lurus, garis lurus biasanya diidentikan dengan kesan kaku, variasi ini biasanya 

digunakan sebagai  simbol formalitas. 

2. Garis lengkung, penggunaan garis lengkung biasanya memberikan kesan lembut dan 

luwes. 

3. Garis zigzag, garis zigzag sering dimaknai sebagai garis yang keras sekaligus dinamis. 

4. Garis tidak beraturan, garis ini bisanya menimbulkan kesan fleksibel dan informal. 

5. Garis horizontal, horizontal melambangkan kesan pasif. 

6. Garis vertikal, vertikal sering dimaknai sebagai bentuk garis yang memiliki kesan stabil. 
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7. Garis diagonal, garis ini dapat diartikan sebagai makna aktif, dinamis dan menarik 

perhatian. 

penggunaan garis sendiri dapat memberikan perbedaan dalam perasaan dan juga dalam 

menstimulus ataupun mengeksekusi sebuah gagasan atau ide. Misalnya saja dengan 

mengubah tekanan, lekukan, ketebalan, akan menimbulkan hasil yang berbeda. Penggunaan 

garis dalam desain komunikasi visual tidak terikat dengan aturan  dam pakem tertentu, 

karena pada dasarnya garis merupakan sebuah elemen visual yang dapat dipakai dimana 

saja. 

 

 

 

 

Dalam penggunaanya, sebuah garis perlu diperhitungkan secara cermat, sehingga tidak 

terkesan asal-asalan dan dipaksakan. Penggunaan variasi garis yang sangat bagus akan 

menambah unsur estetika dan kenyamanan untuk orang yang melihat. Karena tujuan dari 

desain komunikasi visual sendiri adalah untuk menyajikan informasi baik verbal maupun 

visual agar dapat sampai dengan mudah, menyenangkan, sekaligus mengesankan. Desainer 

grafis sering kali juga menggunakan unsur garis sebagai ilustrasi. Didalam aplikasi komputer 

garis biasa dibuat dengan menggunakan Software berbasis Vector salah satunya adalah 

Corel Draw untuk membuat sebuah garis pada corel draw dapat menggunakan fasilitas free 

hand tool, pentool, beizer tool dll dan untuk ketebalan dan jenis garis dapat menekan 

tombol F12 pada key board berikut gambarannya : 
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Untuk Penjelasan Lebih Lanjut dapat dilihat di Video Tutorial 3.A Unsur-Unsur Desain Grafis ( 

Garis ) 

3. Bidang (Shape) 

Bidang atau biasanya juga disebut shape merupakan segala bentuk apapun yang memiliki 

dimensi tinggi dan lebar bidang dapat berupa bentuk-bentuk geometris seperti (lingkaran, 

segitiga, segiempat, elips, setengah lingkaran, dan sebagainya) dan bentuk-bentuk yang 

tidak beraturan. Bidang geometris memiliki kesan yang formal, sedangkan bidang non 

geometris memiliki kesan yang lebih dinamis dan tidak formal. 

 

 

 

Sifat/ karakter bidang sebagai unsur penyususn tata letak diantaranya sebagai berikut : 

1. Bidang horizontal dan vertikal memberikan kesan tenang, statis, stabil dan teratur 

2. Bidang bundar memberikan kesan santai kadang stabil, kadang gerak 

3. Bidang segitiga memberikan kesan statis maupun dinamis 

4. Bidang bergelombang memberikan kesan irama kehidupan dan gerak 

Untuk membuat bidang shape pada aplikasi CorelDraw dapat menggunakan rengtangle tool 

(F6), Ellipse tool (F7), Polygonal tool (Y) maupun Basic Shape tool apabila ingin membuat 

bidang yang lain 

Untuk mengkombinasikan beberapa shape di CorelDraw dapat menggunakan fasilitas 

Combine (Ctrl + L)  atau menggunakan fasilitas shaping Weld, Trim, Interset, Simply 



 
Modul Desain Grafis Level III KKNI      12 
 

 

 

 

Untuk Penjelasan Lebih Lanjut dapat dilihat di Video Tutorial 3.A Unsur-Unsur Desain Grafis ( 

Shape ) 

4. Tekstur (Texture) 

Dalam desain grafis tekstur adalah nilai halus dan kasarnya sebuah benda, atau juga bisa 

disebut nilai raba. Penggunaanya dapat dimayakan untuk memberikan visual yang berkesan 

dan berkarakter. Dalam sebuah desain komunikasi visual tekstur sering digunakan untuk 

mengatur keseimbangan dan kontras. Pada prakteknya tekstur sering dikategorikan sebagai 

corak dari suatu permukaan benda, misalnya permukaan karpet, baju, kulit, kayu, dan 

sebagainya. Penggunaan tekstur dalam desain grafis juga biasanya sering diaplikasikan pada 

latar desain atau sering kita sebut background desain.  

 

 

Untuk Membuat Tekture pada CorelDraw Menggunakan fasilitas texture fill seperti pada 

gambar berikut : 
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Untuk Penjelasan Lebih Lanjut dapat dilihat di Video Tutorial 3.A Unsur-Unsur Desain Grafis ( 

Texture ) 

5. Ruang (Space) 

Ruang atau space merupakan jarak antara suatu bentuk dengan bentuk yang lainnya, yang 

pada desain grafis biasanya dapat dijadikan sebagai unsur pemberi efek estetika desain. 

Dalam pengertian desain grafis area yang kosong yang berada diantara elemen-elemen 

visual juga dianggap sebagai elemen desain. Bidang kosong dimaksudkan untuk menambah 

kesan nyaman dan “istirahat” serta memberikan kesan tekanan kepada objek visual yang 

ada dalam sebuah desain. 

 

 

6. Ukuran (Size) 

Ukuran adalah unsur lain dalam desain grafis yang mendefinisikan besar kecilnya suatu 

objek. Unsur ini digunakan untuk memperlihatkan  objek manakah yang kita mau tonjolkan 

karena dengan menggunakan unsur ini seorang desainer grafis akan dapat menciptakan 

kontras dan penekanan (emphasis) pada objek desain sehingga orang akan tahu skala 

prioritas objek yang akan dilihat terlebih dahulu dibandingkan yang lainnya, misalnya saja 

untuk ukuran suatu judul akan lebih besar dari skala objek yang lainnya. 
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Untuk Penjelasan Lebih Lanjut dapat dilihat di Video Tutorial 3.A Unsur-Unsur Desain Grafis ( 

Size, Rotate, Skew & Miror) 

 

 

7. Warna (Colour) 

Warna adalah elemen dari unsur desain grafis yang menjadi penarik perhatian paling utama. 

Penggunaan warna yang tepat akan berbanding lurus dengan kualitas, citra, keterbacaan, 

dan penyampaian pesan dalam desain tersebut. semisal adalah untuk penggunaan warna 

yang lembut akan memancarkan kesan romantis, kedamaian, dan kenyamanan. Sedangkan 

warna-warna tegas dan terang akan memberi kesan dinamis. Menghindari memadukan 

warna yang salah adalah sangat penting untuk menjauhi penafsiran yang salah oleh orang 

yang melihatnya. 

Warna memiliki karakteristik, kegunaan, dan makna masing-masing. Dalam seni rupa, warna 

dibagi kedalam 3 dimensi, yaitu: 

 Dimensi Pertama: Hue 

Pembagian warna berdasarkan nama-nama warna, seperti merah, kuning, hijau, dan 

lainnya. Berdasarkan Hue, kemudian warna dibagi lagi kedalam tiga golongan yaitu warna 

primer (merah, kuning, biru), dan warna sekunder yang merupakan campuran dua warna 

primer dengan komposisi yang seimbang. Misalnya percampuran warna kuning dan biru 

akan menghasilkan warna hijau. 

 Dimensi Kedua: Value 

Value merupakan dimensi terang-gelapnya warna, pada dasarnya setiap warna bisa 

diterangkan yang kemudian hasilnya kan menjadi warna yang lebih muda. Contohnya adalah 

jika warna biru diterangkan akan menghasilkan biru muda. 

 Dimensi Ketiga: Intensity 
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Intensity dapat diartikan sebagai tingkat kemurnian atau kejernihan warna (brigtness of 

colour). Warna-warna yang belum dicampur dan masih murni disebut pure hue. Para pelukis 

atau desainer grafis pada umumnya lebih sering mengekspresikan karyanya dengan warna-

warna turunan, karena biasanya warna-warna murni terlalu mentah untuk diaplikasikan 

dalam sebuah lukisan. 

 

 

 

 

 

Untuk Aplikasi pewarnaan di dalam CorelDraw kita dapat menggunakan fasilitas  

 

Untuk Penjelasan Lebih Lanjut dapat dilihat di Video Tutorial 3.A Unsur-Unsur Desain Grafis ( 

Warna) 

 

8. Gelap Terang 

Gelap terang merupakan unsur seni rupa yang memberikan identitas bentuk pada suatu 

karya. misalnya permainan gelap terang pada lingkaran, sehingga terlihat seperti bola 

(bentuk 3 dimensi). bisa juga digunakan untuk memberikan kesan kedalaman, kesan jauh 

dan dekat.  

Unsur yang membentuk gelap terang pada seni rupa adalah hitam dan putih. semakin 

banyak memberikan campuran hitam kedalam desain maka terlihat semakin gelap, 
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sedangkan putih jika diberi banyak akan menghasilkan kecerahan. selain itu, gelap terang 

bisa terjadi akibat intensitas cahaya pada objek. 

 

Pengaturan Gelap Terang Pada Corel Draw 

 

2. Prinsip Desain Grafis 

Desain grafis juga sama seperti disiplin ilmu lainnya. yakni memiliki beberapa aturan yang 

ketat, agar menghasilkan keseimbangan dan pekerjaan tetap stabil. Adapun prinsip prinsip 

desain grafis sebagai berikut : 

1. Keseimbangan (Balance) 

Pastikan untuk mengingat bahwa setiap elemen dalam suatu desain memiliki bobot. bobot 

ini bisa berasal dari warna, bentuk, ukuran dan tekstur. dengan memahami keseimbangan, 

kita akan memikirkan penempatan element pada desain, agar tidak terhambur. misalnya 

tidak menempatkan elemen yang berbobot tinggi pada satu tempat saja. ini akan 

menimbulkan efek negatif pada sisilain dalam desain, seolah bagian lain tidak begitu 

penting. padahal dalam suatu kesatuan desain, semuanya memilki peran penting. Terkadang 

dua buah benda belumtentu lebih berat daripada satu benda. 
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Tanpa keseimbangan, desain kita bisa menjadi kacau dan terlihat terhambur. perlu diketahui 

bahwa prinsip keseimbangan desain terbagi menjadi dua, yakni : 

 Keseimbangan Simetris adalah keseimbangan formal dalam gambaran visual. 

maksudnya adalah keseimbangan yang memiliki kesamaan persis baik itu ukuran, 

bentuk dan warna. misalnya ketika membelah dua sebuah lingkaran. Memiliki ukran 

yang sama dan letak yang simetris. Untuk keseimbangan simetris ini memiliki kesan 

sederhana dan resmi atau formil. 

 

 

 

 

 

 Keseimbangan Asimetris adalah keseimbangan tidak formal dalam gambaran visual. 

maksudnya adalah keseimbangan yang tidak semuanya memiliki kesamaan. namun ada 

satu lingkup yang membuatnya terlihat seimbang. Misalnya, 2 bulatan kecil secara 

vertikal berdampingan dengan persegi panjang vertikal. tinggi dan lebih dari keduanya 

sama, namun keduanya memilki bentuk berbeda. 
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2. Kesatuan (Unity) 

Prinsip Kesatuan dalam desain dapat didefinisikan sebagai pengaturan yang tepat pada 

elemen-elemen desain untuk memberikan keselarasan secara keseluruhan. desainer 

menggunakan kesatuan agar elemen-elemen dalam suatu komposisi tampak berhubungan. 

ketika setiap elemen memiliki hubungan visual yang jelas antara satu dan lainnya, maka 

lebih mudah disatukan. ketika persatuan sudah tercapai : 

 Komposisi menjadi tidak berantakan atau membingungkan 

 Desain lebih terorganisasi  dan membangkitkan kualitasnya 

 Konsep akan dkomunisasikan dengan lebih jelas 

 

 

 

 

 

 

 

 

Langkah-langkah menata tata letak untuk menciptakan kesatuan ( unity) : 

1. Membentuk suatu hirarki dari jenis ukuran untuk unsur utama, subheads, teks, dan lain-

lain sesuai dengan format 

2. Mendekatkan elemen-elemen agar berdampingan atau bersinggungan 

3. Konsisten dengan jenis font, ukuran dan gaya untuk judul, subheads, keterangan, 

headers, footers, dll pada beberapa media 

4. Menggunakan palet warna yang sesuai dengan tema (misalnya warna merah untuk 

tulisan Red 

5. Memperderetkan foto dan teks yang sama dengan grid baris 
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3. Kesebandingan (Proporsi)  

Kesebandingan (proporsi) merupakan perbandingan ukuran yang digunakan untuk 

menentukan perbandingan yang dianggap tepat antara panjang dengan lebar antara 

bagian lain atau bagian dengan unsur secara keseluruhan. Sejak jaman klasik sudah 

digunakan teori kesebandingan yang dikenal dengan The Golden Section yang sudah 

banyak diterapkan dalam bidang seni, arsitektur dan spiritual karena pendekatannya 

terkaitdengan hal yang bersifat ideal. Golden Section juga dikenal dengan nama The 

Golden Mean, Golden Ratio, Divine Proportion. Golden Section yang termasuk di 

dalamnya satu set kontruksi geometrik untuk memisahkan satu ruas garis menjadi 

banyak bagian dimana rasio/ perbandingan garis yang panjang berbanding total panjang 

garis sama dengan atau mendekati nilai perbandingan dari garis yang pendek 

berbanding dengan garis yang panjang. Komposisi perbandingan ini menciptakan sebuah 

bentuk yang diangga sempurna. Banyak diantara karya-karya seni terkenal 

menggunakan konsep golden ratio salah satunya lukisan terkenal monalisa. Yang 

memiliki golden ratio ( Rasio emas) 1 : 1.618 

Pada saat ini Golden Ratio banyak digunakan dalam mendesain layout web, majalah, surat 

kabar, flayer dan leaflet. 
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Langkah-langkah menata tata letak untuk menciptakan proporsi 

1. Tentukan unsur-unsur yang akan ditampilkan dalam layout 

2. Tentukan unsur utama yang akan menjadi pusat perhatian 

3. Unsur yang menjadi prioritas dan sebagai pendukung dapat menggunakan warna 

yang mencolok atau sebaliknya 

4. Berikan ruang kosong untuk memberikan kesempatan kepada unsur utama untuk 

menyampaikan pesannya 

5. Mainkan beberapa bidang atau unsur dengan variasi ukuran sesuai peran masing-

masing dalam komposisi tersebut. 

4. Irama ( Rythm) 

 

 

 

 

 

 

 

 

 

 

Rythm adalah pembuatan desain dengan prinsip yang menyatukan irama. Bisa juga 

berarti pengulangan atau variasi dari komponen-komponen desain grafis. Irama 

dihasilkan oleh unsur-unsur yang berbeda dengan pola yang berirama dan unsur serupa 

serta konsistensi. Jenis irama meliputi regular, mengalir(flowing), dan prosesif atau 

gradual. Dengan adanya irama dapat mengajak audiens untuk mengikuti arah gerakan 

yang terjadi pada sebuah karya visual. 
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Langkah-langkah menata desain untuk menciptakan irama : 

1. Gandakan objek dengan bentuk dan ukuran yang sama untuk menciptakan sebuah 

ritme biasa 

2. Gandakan objek dengan variasi ukuran semakin besar atau dengan variasi bentuk 

yang berbeda untuk menciptakan ritme yang dinamis 

3. Menggandakan Objek dengan bentuk yang sama untuk menciptakan objek baru 

4. Untuk media yang terdidri dari beberapa halaman masukan unsur dan posisi yang 

sama pada setiap halaman, mislanya buku/newsletter 

5. Untuk yang terbit beberapa edisi perlu penempatan unsur-unsur yang sama pada 

posisi pada setiap edisi misalnya newsletter atau majalah. 

5. Kontras/ Penekanan (Emphasis) 

Kontras adalah prinsip desain yang penting karena memungkinkan kita untuk menarik 

elemen-elemen terpenting pada desain dan memberikannya penekanan. kontras terjadi 

ketika dua elemen desain bertentangan satu sama lain, misalnya: warna hitam dan putih, 

kotak dan bulat, titik dan garis, tebal dan tipis, modern dan tradisional. 

Dengan kekontrasan desain, kita bisa memandu mata audiens menuju kebagian terpenting 

dari desain dan membantu mengatur informasi lebih mudah. contoh sederhananya :  

 Warna background harus berlawanan dengan warna tulisan, agar lebih mudah dibaca. 

 Memberikan penebalan, warna berbeda pada teks terpenting dari desain 

Ketika ingin mencari contoh desain 

yang benar-benar kuat kontrasnya, pasti 

didalamnya hanya menampilkan 2 

Jenis font berbeda saja. itu karena kontras 

dapat dicapai secara efektif  dengan 

dua font berbeda dan satunya itu 

memiliki bentuk yang kuat. jika 

ditambahkan lagi satu jenis font, maka itu mungkin akan mengacaukan. kecuali kita bisa 

menetralisisrnya dengan menggunakan prinsip desain lainnya. 
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Kontras dapat memperkuat kesan yang ditumbulkan dalam sebuah ilustrasi 

Dengan menggunakan kontras pesan penting yang harus disampaikan menjadi lebih 

menarik dan fokus. Dalam menciptakan kontras janganlah terlalu berlebihan justru akan 

menimbulkan kerumitan, ketidak beraturan, kontradiksi yang jauh dari harmonis. 

Langkah- langkah menciptakan kontras pada karya desain : 

1. Masukan objek, ilustrasi atau unsur lainnya dengan ukuran yang berbeda 

2. Letakan bagian yang penting dari teks (headline) pada sudut melengkung atau posisi 

yang berbeda daripada teks yang lainnya di kolom lurus 

3. Gunakan huruf tebal, hitam untuk headline dan jenis teks ringan untuk bodytext  

4. Buatlah bidang yang besar di sebelah gambar kecil/ sedikit teks 

5. Pilihlah warna yang berlawanan antara unsur utama untuk memisahkan penekanan 

6. Gunakan jenis font yang berbeda untuk headline yang membawa informasi penting 

dengan informasi pendukung 

 

6. Keselarasan ( Harmony)  

Keselarasan merupakan prinsip desain yang diartikan sebagai keteraturan tatanan diantara 

bagian-bagian suatu karya. Keselarasan dalam desain merupakan pembentukan unsur-unsur 

keseimbangan, keteraturan, kesatuan dan perpaduan masing-masingsaling mengisi dan 

menimbang. Keselarasan ( harmony) bertindak sebagai faktor pengaman untuk mencapai 

keserasian seluruh rancangan penyajian. Keserasian atau harmoni dapat dicapai dengan 

mengatur kesamaan arah, kesamaan bentuk meskipun berbeda ukuran atau dengan tekstur 

yang memiliki sifat sama. Pakailah warna gelap untuk yang memiliki karakter berat dan 

warna terang untuk yang berkarakter ringan. 

Harmoni dapat diwujudkan dengan 2 cara yaitu : 
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a. Harmoni dari segi bentuk 

Harmoni yangdilihat dari bentuk ialah dimana adanya keserasian dalam penenmpatan 

unsur-unsurnya. Hal itu dapat dilihat dari segi bentuk dan ukurannya pada media 

misalnya brosusr, leaflet, poster dll. Pemilihan bentuk huruf juga memiliki sebagaimana 

untuk tujuan apa desain itu dibuat.  

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Harmoni dari segi warna 

Warna memiliki pengaruh yang sangat besar, karena setiap warna memiliki sifat masing-

masing, seperti merah yang memiliki kesan berani, biru yang memiliki kesan tenang dan 

lain sebagainya. Perpaduan yang baik antara warna-warna tersebut akan mampu 

menciptakan sebuah harmoni yang indah dan menarik 

  

Contoh harmoni dari segi bentuk 

dan penyusunannya 
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Tujuan Pembelajaran : 

Setelah mempelajari bab 4 ini diharapkan peserta didik mampu : 

1. Memahami proses terjadinya warna 
2. Mengenal komponen warna 
3. Mengenal model warna 
4. Mengenal fungsi dan karakter masing-masing warna 
5. Memahami berbagai skema warna 
6. Menganalisis sifat warna pada sebuah karya desain 

 

 

 

 WARNA 

 

 

 

 

 

 

 

 

 

1. Apakah Warna Itu ? 

Warna merupakan fenomena yang terjadi karena adanya tiga unsur yaitu cahaya, objek dan 

pengamat ( observer). Warna dapat di definisikan secara objektif / fisik sebagai sifat cahaya 

yang dipancarkan, atau secara subjektif/ psikologis merupakan bagian dari pengalaman 

indera penglihatan. Proses terlihatnya warna adalah dikarenakan adanya cahaya yang 

menimpa suatu benda, dan benda tersebut menyerap serta memantulkan cahaya sampai ke 

mata sehingga terlihatlah warna. Jadi syarat terjadinya warna harus ada cahaya, objek ( 

benda) dan pengamat (mata atau alat).  

 

 

 

 

 

 

Gambar 4.1 Proses warna 

dapat terlihat oleh mata 
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2. Jenis –jenis warna  

Pengetahuan mengenai warna sangat penting bagi mereka yang bekerja dibidang desain 

grafis khusunya. Sebelum menentukan warna dalam mendesain sebaiknya  kita mengenal 

dulu lingkaran warna. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.2 Lingkaran warna 

Jenis- jenis kombinasi warna dalam lingkaran warna berdasar komponen penyususnya 

terdiri atas beberapa bagian yaitu : 

a. Warna primer, adalah warna dasar atau warna pokok dalam lingkaran warna yang tidak 

dapat diperoleh dari campuran warna lain. Warna primer terdiri dari 3 warna dasar yaitu 

Red, Yellow, Blue atau dalam bahasa indonesia Merah Kuning dan Biru. Dalam dunia 

desain grafis dikenal sebagai warna pigmen. Warna lain terbentuk dari kombinasi warna 

primer itu sendiri. 

b. Warna Sekunder, adalah warna yang diperoleh dari campuran dua warna primer dengan 

perbandingan yang sama. Warna sekunder terdiri dari warna Ungu ( pencampuran 

warna merah dan biru), Orange/ jingga ( pencampuran warna merah dan kuning), dan 

hijau ( pencampuran warna biru dan kuning ) 
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c. Warna Tertier,  adalah warna yang merupakan hasil pencampuran antara  warna primer 

dan sekunder di sebelahnya dengan perbandingan yang sama. 

Sedangkan menurut proses pencampuran warna pada perangkat atau peralatan, warna 

dibedakan menjadi 

1. Warna Additive  

Adalah pencampuran warna primer cahaya yang terdiri dari warna red (merah), green 

(hijau) dan blue (biru) yang disebut dengan istilah RGB, dimana pencampuran ketiga 

warna primer dengan jumlah yang sama akan menghasilkan warna putih. Kombinasi 

antara dua warna primer akan menghasilkan warna skunder. warna skunder adalah Cyan 

(biru kehijau-hijauan) yaitu gabungan warna green dan blue, magenta (merah keungu-

unguan) yaitu gabungan warna blue dan red dan yellow (kuning) yaitu gabungan warna 

red dan green. cara pencampuran warna additive diterapkan pada monitor, TV, Video, 

Scanner dan lain-lain. 

 

 

 

 

 

 

2. Warna Subtractive 

Adalah warna skunder dari warna additive, namun secara material warna subtractive 

berbeda dengan warna additive. warna additive dibentuk dari cahaya, sedangkan warna 

subtractive dibentuk dengan pigment warna yang bersifat transparan. tinta cetak adalah 

contoh dari pencampuran warna subtractive. warna subtractive terdiri atas cyan, 

magenta dan yellow, secara teori pencampuran ketiga warna subtractive akan 

menghasilkan warna hitam, tetapi kenyataan dilapangan adalah warna coklat tua 

(karena keterbatasan pigment tinta cetak) oleh sebab itu ditambahkan warna hitam 

(black) dinyatakan dengan simbol K berasal dari kata Key untuk menambah 

kepekatannya. saat ini warna CMYK menjadi standard dalam proses cetak warna di 

industri grafika. 

Gambar 4.3 Warna Additive 

 Red, Green & Blue 
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3 Model Warna 

Model warna adalah sebuah model matematika abstrak yang menjelaskan bagaimana 

warna dapat disajikan sebagai sebuah tupel dari angka-angka, biasanya tiga atau empat nilai 

atau komponen warna. Macam-macam model warna tersebut sebagai berikut : 

a. Model Warna RGB 

Model Warna RGB adalah sebuah model warna additif dimana pancaran warna red 

(merah), green (hijau), dan blue (biru) ditambahkan bersama dengan cara yang bervariasi 

untuk mereproduksi susunan warna yang lebar. Warna aditif digunakan untuk lighting, 

video, dan monitor. Monitor sebagai contoh, menciptakan warna dengan memancarkan 

cahaya melalui merah, hijau dan biru fosfor. 

Tujuan utama dari model warna RGB adalah untuk mempresentasikan ulang, dan 

menampilkan gambar dalam sistem elektronik, misalnya dalam televisi dan komputer. 

Model warna RGB juga digunakan dalam fotografi konvensional.  

RGB adalah sebuah ruang warna yang sifatnya bergantung kepada perangkat. Perangkat 

yang berbeda akan mendeteksi atau mereproduksi nilai RGB secara berbeda. Untuk 

membentuk warna dengan RGB, tiga cahaya berwarna balok (satu merah, satu hijau, dan 

satu biru) harus ditumpangkan (misalnya dengan emisi dari layar hitam, atau dengan refleksi 

dari layar putih). Masing-masing dari tiga balok disebut sebagai komponen warna, dan 

masing-masing dapat memiliki intensitas yang berbeda. 

RGB sering digunakan dalam perangkat input seperti: TV berwarna dan kamera video, 

Scanner, dan kamera digital. Perangkat output seperti: TV dalam berbagai teknologi (CRT, 

LCD, plasma, dll), komputer dan layar HP, video proyektor, layar LED multiwarna, dan layar 

lebar seperti JumboTron, dll.  

RGB juga umumnya digunakan dalam pembuatan desain sebuah website. Awalnya 

kedalaman warna yang terbatas pada sebagian besar perangkat keras video memicu 

Gambar 4.4  Warna  Subtractive  

Red, Green & Blue 
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keterbatasan palet warna menjadi 216 warna RGB, hal itu ditetapkan oleh Netscape Color 

Cube. Namun, dengan keunggulan menampilkan 24-bit, penggunaan penuh dari 16.7 juta 

warna dari kode warna RGB HTML tidak lagi menimbulkan masalah bagi sebagian besar 

pengunjung website. 

 

Pengkodean warna RGB dapat ditulis dalam angka hexadesimal (basis 16) untuk masing-

masing komponen R, G atau B. Misalkan: 

 Untuk Hitam murni akan ditulis dengan kode #000000 (R=00, G=00, B=00) 

 Untuk Putih sempurna akan ditulis dengan kode #FFFFFF (R=FF, G=FF, B=FF) 

 Untuk Biru murni akan ditulis dengan kode #0000FF (R=00, G=00, B=FF), dst 

b. Model Warna CMYK 

CMYK adalah kependekan dari Cyan, Magenta, Yellow (kuning) dan warna utamanya 

yaitu blacK (hitam) dan sering kali  dijadikan referensi sebagai suatu proses pewarnaan 

dengan mempergunakan empat warna). CMYK adalah bagian dari model pewarnaan yang 

sering dipergunakan dalam pencetakan berwarna. Namun ia juga dipergunakan untuk 

menjelaskan proses pewarnaan itu sendiri. Meskipun berbeda-beda dari setiap tempat 

pencetakan, operator surat kabar, pabrik surat kabar dan pihak-pihak yang terkait, tinta 

untuk proses ini biasanya, diatur berdasarkan urutan dari singkatan tersebut. 

K dalam CMYK berarti Key, karena dalam pencetakan empat warna yaitu Cyan, Magenta, 

Yellow mencetak plat yang secara hati – hati terkunci atau sejajar dengan kunci dari kunci 

plat hitam.  Beberapa sumber menyatakan bahwa K berasal dari huruf terakhir black, karena 

huruf pertama yaitu B sudah digunakan untuk mendefinisikan warna Blue (biru) dalam 

model warna RGB.  

Model ini, baik sebagian ataupun keseluruhan, biasanya ditimpakan dalam gambar 

dengan warna latar putih (warna ini dipilih, dikarenakan dia dapat menyerap panjang 

struktur cahaya tertentu). Model seperti ini sering dikenal dengan nama "subtractive", 

karena warna-warnanya mengurangi warna terang dari warna putih. 

Dalam model yang lain "additive color", seperti halnya RGB (Red-Merah, Green-Hijau, 

Blue-Biru), warna putih menjadi warna tambahan dari kombinasi warna-warna utama, 

sedangkan warna hitam dapat terjadi tanpa adanya suatu cahaya. Dalam model CMYK, 
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berlaku sebaliknya warna putih menjadi warna natural dari kertas atau warna latar, 

sedangkan warna hitam adalah warna kombinasi dari warna-warna utama. Untuk 

menghemat biaya untuk membeli tinta, dan untuk menghasilkan warna hitam yang lebih 

gelap, dibuatlah satu warna hitam khusus yang menggantikan warna kombinasi dari cyan, 

magenta dan kuning.  

c. Model Warna HSL 

HSL adalah suatu model warna yang diperoleh dari color space RGB dan device 

dependent color space. HSL kependekan dari hue, saturation dan lightness. Di dalam HSL, 

ketiga karakteristik pokok dari warnanya adalah:             

1) Hue: adalah warna yang dipantulkan dari atau memancarkan melalui suatu obyek. Itu 

diukur sebagai lokasi pada standard color wheel, yang dinyatakan dalam tingkat antara 

0o dan 360o. Pada umumnya, hue dikenali dengan nama dari warna seperti merah, 

orange atau hijau. 

2) Lightness: adalah tingkat keterangan relatif atau kegelapan dari warna. Pada umumnya 

diukur dalam presentase dari 0% (hitam) ke 100% (putih). 

3) Saturation: kadang – kadang disebut chroma, adalah kemurnian atau kekuatan dari 

warna. Saturation menghadirkan jumlah kelabu sebanding dengan Hue, mengukur 

persentase dari 0% (Hitam)Kelabu sampai 100% ( warma yang dipenuhi ). Pada standar 

color wheel, saturation meningkatkan dari pusat ke tepi. 

 

 

 

 

 

 

 

 

HSL dapat dianggap sebagai warna yang menggambarkan sebagai titik-titik dalam 

sebuah silinder (disebut warna solid) yang poros tengah berkisar dari hitam di bagian bawah 

untuk putih di bagian atas. Sudut sekitar sumbu terkait dengan "warna", jarak dari sumbu 
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terkait dengan "kejenuhan", dan jarak sepanjang sumbu terkait dengan "ringan", "nilai" atau 

"terangnya".  

Secara konseptual HSL mewakili sebuah kerucut ganda atau bola (dengan putih di bagian 

atas, hitam di bagian bawah, dan penuh warna jenuh sekitar tepi horizontal penampang 

dengan tengah berwarna abu-abu pada pusatnya).  

d. Model Warna Lab 

Warna Lab berdasar kepada persepsi manusia atas warna, merupakan salah satu dari 

beberapa model warna yang diproduksi oleh Commission Internationale d’Eclairage (CIE), 

suatu organisasi yang dipersembahkan untuk menciptakan standard untuk semua aspek 

cahaya. 

Nilai numeric di dalam Lab menguraikan semua warna yang ditangkap seseorang dengan 

penglihatan normal. Sebab, Lab menguraikan bagaimana suatu warna dilihat dibandingkan 

dengan beberapa banyak bahan warna tertentu yang diperlukan untuk suatu alat (seperti: 

suatu monitor, desktop printer, atau kamera digital) untuk menghasilkan warna. Lab 

dianggap sebagai suatu device-independent color model. Color management system 

menggunakan Lab sebagai acuan warna untuk perubahan yang dapat diramalkan, suatu 

bentuk warna dari satu color space ke color space yang lain. Lab menguraikan warna dalam 

kaitannya dengan luminance atau lightness-components (L) dan dua chromatic components 

(a), komponen merah dan hijau dan (b) komponen (kuning dan biru). 

 

 

 

 

 

 

 

 

 

 

 

White L* = 

Black L* = 

0 
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Berbeda dengan RGB dan CMYK color model, warna LAB dirancang untuk mendekati 

penglihatan manusia. Hal itu menginspirasikan untuk keseragaman persepsi, dan komponen 

L-nya secara erat cocok dengan persepsi manusia tentang Lightness (kecerahan). Hal 

demikian dapat digunakan untuk membuat koreksi keseimbangan warna yang akurat 

dengan memodifikasi output kurva di komponen a dan b, atau untuk menyesuaikan kontras 

ringan menggunakan komponen L. 

 

3 Fungsi & Karakter Warna 
  

Warna memiliki beberapa fungsi yaitu : 

1. Fungsi Identitas 

Warna memiliki kegunaan atau fungsi untuk mempermudah orang untuk mengenali 

identitas suatu kelompok, brand, perusahaan, bahkan suatu organisasi. Sebagai contoh, 

warna hijau banyak digunakan untuk organisasi keagamaan di Indonesia. Inilah mengapa 

warna sangat penting karena kita bisa melihat suatu tujuan organisasi hanya dari warnanya 

saja. 

2. Fungsi Isyarat dan Komunikasi 

Berkomunikasi dengan warna? Yes, inilah fungsi lainnya dari sebuah warna. Kita ambil 

contoh, dalam suatu pertempuran salah satu kubu mengibarkan bendera warna putih, yang 

berarti sebagai tanda menyerah. 

Selain itu, warna sebagai media berkomunikasi juga sering kita temukan di lampu lalu lintas, 

dimana lampu dengan warna hijau berarti jalan, kuning berarti bersiap dan merah berarti 

berhenti. Dengan adanya warna inilah isyarat sebuah perintah bisa tersampaikan hanya 

dengan warna saja. 

3. Fungsi Psikologis 

Dari sudut pandang kejiwaan warna bisa dikaitkan dengan karakter-karakter manusia. Orang 

yang mempunyai karakter extrovert lebih senang dengan warna-warna panas dan cerah. 

Karena tipe orang seperti ini biasanya terbuka, lebih memandang ke luar daripada kedalam 

diri sendiri. 

4. Fungsi Alamiah 

Warna adalah properti benda tertentu dan merupakan penggambaran sifat obyek secara 

nyata. Atau warna mampu menggambarkan sifat obyek secara nyata. Sebagai contoh, warna 
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hijau untuk menggambarkan daun, rumput dan warna biru untuk laut, langit dan 

sebagainya. 

5. Fungsi Pembentuk Keindahan ( Estetika ) 

Keberadaan warna memudahkan setiap orang dalam melihat dan mengenali suatu benda. 

Contohnya apabila kita meletakan benda di tempat yang sangat gelap, mata kita tidak 

mampu mendeteksi obyek tersebut dengan jelas. Warna membuat objek menjadi lebih 

indah dan enak untuk dipandang. 

 

 

 

 

 

 

 

 

 

4. Karakter / Psikologi Warna 

Warna memiliki kekuatan untuk mempengaruhi psikologi seseorang. Berikut ini adalah 

kemampuan warna dalam memberikan respon psikologis kepada audien 

1. Warna Kuning 

Warna matahari ini sangat mudah dipahami dan mampu membangkitkan perasaan 

optimisme, kejelasan, dan kehangatan. Kuning juga merupakan warna yang kaya, seperti 

warna yang ada pada emas dan harta karun. Warna terang seperti kuning dapat 

menonjol, bahkan ketika ia digunakan di lingkungan yang ramai. 
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2. Warna oranye adalah warna yang selalu menarik perhatian. Warna oranye mengirimkan 

pesan yang mengatakan, “Saya tidak takut untuk menjadi pusat perhatian.” Oranye 

melambangkan antusias, percaya diri, dan gembira. 

 

 

 

 

3. Warna Merah ; Warna ini dapat benar-benar menaikkan denyut nadi orang ketika 

mereka melihat warna merah. Ini adalah warna kuat yang hangat, menarik, seksi, dan 

mendesak. Ini adalah warna darah dan asmara, simbol stop dan mawar klasik. 

 

4. Warna Ungu ; Warna ini adalah warna kerajaan yang bisa memberikan gambaran 

keagungan, kemewahan, dan mistisisme. Ini akan mengaktifkan imajinasi dan memikat 

mata. Ungu juga banyak dikaitkan dengan kebijaksanaan. 
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5. Warna Biru ; Warna ini dapat menyampaikan perasaan kekuatan, kehandalan, dan 

ketenangan seperti sifat air. Dengan warna biru pada desain Anda, maka akan 

mendorong audience untuk melihat perusahaan dengan keseriusan dan kepercayaan. 

 

 

 

 

 

6. Warna hijau dapat menyampaikan perasaan tenang, damai, dan menyampaikan 

gagasan pertumbuhan. Produk yang menggunakan desain warna hijau akan terkesan 

menawarkan kesegaran dan bersifat natural dari alam. 

 

 

 

 

7. Warna Hitam ; Secara teknis, warna hitam merupakan ketiadaan warna. Hitam 

melambangkan ketegasan, profesional, dan kredibilitas sebuah produk. Makin besar 

Anda ingin memberikan kesan kuat pada perusahaan, maka makin banyak warna hitam 

yang bisa Anda tambahkan. 

 

 

 

 

 

 

8. Warna Coklat ; Warna ini akan memberikan kesan kesederhanaan dan klasik. Jika Anda 

memiliki sebuah produk yang ingin Anda tampilkan dengan kesan sederhana, maka 
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coklat adalah sebuah pilihan yang tepat. Beberapa produk yang bersifat retro atau 

kebahagiaan dalam bernostalgia juga cocok menggunakan warna coklat. 

9. Warna Putih ; Warna ini dapat menyiratkan sesuatu yang bersifat suci, bersih, murni. 

Pemakaian warna putih dalam logo branding perusahaan juga akan memberi kesan 

santun. Warna putih akan terlihat kontras dan tegas jika dipadukann dengan warna 

hitam. 

 

 
 

 

5. Skema Warna 

Skema Warna adalah Penggabungan 2 Warna atau Lebih yang berbeda dalam sebuah 

komposisi. Fungsi Skema Warna “Menciptakan Komposisi warna yang serasi dalam sebuah 

desain sesuai dengan Karakter yang diinginkan”. Macam –macam skema warna diantaranya 

: 

1. Skema Warna Monocromatik ; 

Komposisi yang berasal dari satu warna dengan intensitas yang berbeda, mampu 

menciptakan suasana dengan persepsi warna dasar yang digunakan misalnya merah, 

merah muda, merah gelap. 

 
2. Skema Warna Komplementer 

Kombinasi warna-warna yang tepat bersebrangan dalam lingkaran warna. Perpaduannya 

memiliki kekuatana warna yang berimbang dan saling melengkapi. Bersifat kontras dan 

menghidupkan suasana. Contohnya merah dengan hijau, kuning dengan ungu, atau biru 

dengan orange 

 

 

 

 

 

 

3. Skema Warna Triadic  
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Komposisi tiga warna yang memiliki jarak yang sama antar masing-masing dalam 

lingkaran warna yang termasuk skema warna triad diantaranya yaitu orange, hijau dan 

ungu. Warna warna tersebut memiliki intensitas warna yang sama kuatnya. 

 

 

 

 

 

 

4. Skema Warna Tetradic 

Skema komposisi empat warna yang memiliki jarak sama satu sama lain dalam lingkaran 

warna, contoh merah, orange-kuning, hijau dan biru 

 

 

 

 

 

 

 

5. Skema Warna Split Komplementer 

Skema warna Split komplementer merupakan pengembangan dari skema komplementer 

hanya saja menggunakan 3 warna dimana salah satu ujungnya menggunakan 2 warna 

yang berdampingan dengan warna yang bersebrangan seperti dalam gambar berikut : 

 

 

 

 

 

 

 

6. Skema Warna Persegi  

Skema warna persegi menggunakan 4 warna yang menyerupai bentuk segi empat 

teratur dalam roda warna.  Skema persegi dapat dibentuk dengan memilih salah satu 

warna dalam roda warna kemudian dibuat sebuah persegi yang simetris sama sisi maka 

akan didapatkan 4 warna yang berbeda 
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7. Skema Warna Analog  

Skema warna –warna bersebelahan atau berdekatan dalam lingkaran warna sehingga 

menciptakan keselarasan karena perpindahan antar satu warna dengan yang lain 

berlangsung secara halus tidak terlalu kontras misalnya : kuning, Kuning Jingga, Jingga 
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Tujuan Pembelajaran : 

Setelah mempelajari bab 5 ini diharapkan peserta didik mampu : 

1. Menjelaskan pengertian dan fungsi tipografi 

2. Mengetahui sejarah tipografi 

3. Mengetahui Prinsip-Prinsip Tipografi 

4. Mengetahui Karakter dalam tulisan 

 

 

 

Tipografi 

 

 

 

 

 

 

 

 

 

 

1. Pengertian Tipografi 

Dalam  desain  komunikasi  visual tipografi dikatakan  sebagai  ‘visual  language’, yang berarti 

bahasa yang dapat dilihat. Tipografi adalah salah satu sarana untuk menterjemahkan  kata-

kata yang terucap ke halaman yang dapat dibaca.  Peran  dari pada tipografi  adalah  untuk 

mengkomunikasikan  ide atau informasi dari halaman  tersebut  ke pengamat.  Secara  tidak  

sadar  manusia selalu berhubungan dengan tipografi setiap  hari, setiap saat. Pada merek 

dagang komputer yang kita gunakan,  koran atau majalah yang kita baca, label pakaian 

yang kita kenakan, dan masih banyak lagi.  

 Hampir  semua  hal yang berhubungan  dengan desain komunikasi  visual 

mempunyai  unsur tipografi  di dalamnya. Kurangnya  perhatian  pada  tipografi  dapat  

mempengaruhi  desain  yang  indah  menjadi kurang atau tidak komunikatif. 

Untuk membuat desain yang indah dan berkomunikasi, tipografi tidak dapat 

dipisahkan   dari  elemen  desain.  Dalam membuat  perencanaan suatu karya desain, 
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keberadaan elemen tipografi sudah harus selalu diperhitungkan karena dapat 

mempengaruhi susunan hirarki dan keseimbangan  karya desain tersebut. Pengertian 

tipografi yang sebenarnya adalah ilmu yang mempelajari bentuk huruf; dimana huruf, 

angka, tanda baca, dan sebagainya tidak hanya dilihat sebagai simbol dari suara tetapi 

terutama dilihat sebagai suatu bentuk desain. Huruf ‘O’, contohnya, tidak saja terbaca 

sebagai huruf  ‘O’, tetapi   juga   terbaca sebagai  bentuk  lingkaran yang mempengaruhi  

bidang  suatu  karya  desain. 

2. Sejarah Tipografi 

Tipografi,  sebagai  salah  satu  metode  yang  menterjemahkan  kata-kata  menjadi bentuk  

atau gambaran  sudah  digunakan  sejak  jaman  dahulu.  Dimulai  sejak  awal jaman lukisan  

di gua  (early  cave  drawing  age),  dimana  nenek  moyang  kita  menggambarkan 

pengalaman mereka di dinding gua. Pada awalnya, yang digunakan adalah pictogram, yaitu 

gambar  yang  mewakili  bentuk  benda  yang  dimaksud.   Secara  perlahan,  berdasarkan 

asosiasi, beberapa pictogram berubah menjadi ideogram, yaitu simbol yang bentuknya tidak 

persis  mewakili  bentuk  yang  dimaksud  sehingga  dapat  digunakan  untuk  berbagai  arti. 

3. Prinsip-prinsip Tipografi 

Ada empat buah prinsip pokok tipografi yang sangat mempengaruhi  keberhasilan suatu 

desain tipografi yaitu legibility, clarity, visibility , dan readibility. 

1. Legibility 

Legibility  adalah kualitas pada huruf yang membuat huruf tersebut dapat terbaca. 

Dalam suatu karya desain, dapat terjadi cropping , overlapping, dan lain sebagainya , 

yang dapat menyebabkan berkurangnya legibilitas daripada suatu huruf. 
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Untuk jenis huruf Futura Huruf “a” pada tulisan Karya hampir sama dengan huruf “o” 

pada tulisan Karyo hal ini menyebabkan berkurangnya legibilitas dari tulisan tersebut 

2. Readibility 

Readibility  adalah penggunaan huruf dengan memperhatikan hubungannya dengan 

huruf yang lain sehingga terlihat jelas. Dalam menggabungkan huruf dan huruf baik untuk 

membentuk  suatu  kata, kalimat  atau tidak harus  memperhatikan  hubungan  antara  

huruf yang satu dengan yang lain. Khususnya spasi antar huruf. Jarak antar huruf 

tersebut tidak dapat diukur secara matematika, tetapi harus dilihat dan dirasakan. 

Ketidak tepatan menggunakan   spasi  dapat  mengurangi   kemudahan   membaca   

suatu  keterangan   yang membuat informasi yang disampaikan pada suatu desain 

komunikasi visual terkesan kurang jelas. Huruf-huruf  yang digunakan mungkin sudah 

cukup  legible, tetapi apabila pembaca merasa  cepat  capai  dan kurang  dapat  

membaca  teks tersebut  dengan  lancar,  maka  teks tersebut dapat dikatakan tidak 

readible . Pada papan iklan, penggunaan spasi yang kurang tepat sehingga mengurangi 

kemudahan pengamat dalam membaca informasi dapat mengakibatkan   pesan  yang  

disampaikan   tidak  seluruhnya   ditangkap   oleh  pengamat. Apabila  hal  ini  terjadi,  

maka  dapat  dikatakan  bahwa  karya  desain  komunikasi  visual tersebut gagal karena 

kurang komunikatif.  Kerapatan dan kerenggangan  teks dalam suatu desain juga dapat 

mempengaruhi  keseimbangan  desain 

 

 

 

 

 

 

 

Jarak antar huruf atau kearapatan huruf sangat penting agar tulisan menjadi mudah 

terbaca 

3. Visibility 

Prinsip yang ketiga adalah Visibility. Yang dimaksud dengan visibility adalah kemampuan  

suatu huruf, kata, atau kalimat dalam suatu karya desain komunikasi  visual dapat 

terbaca dalam jarak baca tertentu.  Fonts  yang kita gunakan  untuk  headline  dalam 
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brosur tentunya berbeda dengan yang kita gunakan untuk papan iklan.  Papan iklan 

harus menggunakan  fonts  yang  cukup  besar  sehingga  dapat  terbaca  dari  jarak  yang  

tertentu. Setiap karya desain mempunyai suatu target jarak baca, dan  huruf-huruf yang 

digunakan dalam desain tipografi harus dapat terbaca dalam jarak tersebut sehingga 

suatu karya desain dapat berkomunikasi dengan baik. 

 

  

 

 

 

 

4. Clarity 

Prinsip  pokok yang terakhir adalah  clarity ,  yaitu  kemampuan  huruf-huruf  yang 

digunakan  dalam  suatu  karya  desain  dapat  dibaca  dan dimengerti  oleh target  

pengamat yang dituju.  Untuk suatu karya desain dapat berkomunikasi  dengan  

pengamatnya,  maka informasi yang disampaikan harus dapat dimengerti oleh pengamat 

yang dituju. Beberapa unsur desain yang dapat mempengaruhi  clarity adalah, visual 

hierarchy , warna, pemilihan type, dan lain-lain. 

 

 

 

 

 

 

 

 

 

 

 

 

Setiap Huruf memiliki 

Karakter dan karakter 

tersebut akan 

menggambarkan isi 

dari tulisan tersebut 
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Tujuan Pembelajaran 

5. Peserta Didik mampu memahami desain brief 

6. Peserta Didik Mampu melaksanakan desain brief 

 

 

 

 

    Desain Brief 

 

 

 

Design brief, atau panduan pekerjaan desain, ibarat resep makanan semakin lengkap dan 

akurat makan semakin efektif dan enak makanan yang disajikan. Setiap pekerjaan desain 

akan membutuhkan panduan/brief yang unik dan khusus dibuat agar dapat menghasilkan 

desain yang sesuai/tepat. Meski kerap disepelekan, brief sangat penting untuk membantu 

klien dan designer untuk berkomunikasi dalam bahasa/kerangka/konteks yang sama. 

Brief yang baik memberikan semua informasi dasar yang diperlukan oleh desainer untuk 

menghasilkan pekerjaan yang sesuai dengan ekspektasi klien. 

Secara garis besar design mencakup 2 informasi dasar: 

1. Deskripsi pekerjaan: cakupan proyek, informasi tentang klien dan produk/event, 

hasil desain yang dibutuhkan. 

2. Project management: deliverable (desain final yang diinginkan klien), timeline 

(waktu pengerjaan) dan budget 

Tahapan Menerapkan Desain Brief 

1. PERKENALAN DAN PAHAMI EKSPEKTASI PEKERJAAN 

Di tahap awal ini merupakan saat yang tepat untuk mengenal lebih jauh tentang ekspektasi 

pekerjaan, yang akan membantu kita untuk memutuskan apakah kita orang tepat untuk 

pekerjaan dan dapat memenuhi ekspektasi tersebut. 
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Pada tahap awal komunikasi, PERKENALAN, kita bisa mulai dengan beberapa pertanyaan 

yang membantu mengenal klien dan apa yang mereka butuhkan (jika kita sudah kenal 

dengan kliennya, bagian ini bisa diabaikan): 

 Informasi umum tentang proyek, seperti nama proyek, siapa kliennya, berapa besar 

timnya, apa saja yang klien sudah lakukan terkait proyek ini. 

 How do they find you?  

o Dari siapakah mereka mengenal kita, dari teman kerja atau situs pencari kerja 

atau lainnya? 

o Sudahkah mereka melihat portofolio kita? 

o Kenapa mereka tertarik untuk bekerja sama? 

Tahap selanjutnya: EKSPEKTASI PEKERJAAN, untuk memahami tentang cakupan pekerjaan 

lebih lanjut: 

 What do they want from you?  

o Produk apa yang mereka inginkan 

o Hasil akhir (final artwork) apa yang mereka inginkan 

o Kapasitas tim klien (untuk mengukur seberapa besar keterlibatan kita dalam 

proyek, contoh: apakah sampai hadir dalam presentasi atau sebatas produksi 

saja), atau apakah mereka memiliki tim kreatif/internal internal. 

 Informasi dasar tentang kesiapan materi dan perencanaan.  

o Di bagian manakah kita akan dibutuhkan 

o Siapa sajakah yang akan terlibat dalam proyek, apakah ada tim lain? 

o Materi apa saja yang sudah dimiliki dan disiapkan, apakah semua di-desain dari 

awal, dsb. 

Pertanyaan-pertanyaan ini penting agar kita: 

 cepat memahami cakupan pekerjaan apa yang ditawarkan klien 

 mengukur kemampuan sendiri serta cakupan pekerjaan secara riil. 

 dapat memutuskan apakah kita cocok/mau mengambil pekerjaan ini atau tidak? 
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2. MELENGKAPI BRIEF 

Jika kita memutuskan untuk bekerja dalam proyek ini, kita maju ke tahap selanjutnya 

dimana kita mulai menerima brief. 

Berikut ini daftar informasi yang wajib ada dalam brief pekerjaan desain: 

1. Teknis pekerjaan. Apakah hasil akhir yang diharapkan?  

o Ukuran, bentuk, mock up, dst 

o Dalam media apa saja artwork akan digunakan, kebanyakan di media cetak atau 

digital, atau online,dst. 

o Apakah bentuk/format dari final artwork yang diinginkan? Bentuk 

flattened/template atau format yang bisa diedit, eg. psd, work template, 

powerpoint templates, dst. 

2. Tenggat waktu atau deadline pengerjaan. Jika desain lebih dari 1, pastikan apakah 

deadline-nya sama untuk semua. 

3. Anggaran/budget. Umumnya klien akan meminta kita mengirimkan penawaran 

harga/quotation setelah memberikan detail pekerjaan. 

Jika proyeknya seputar branding, ada beberapa detail informasi lain yang diperlukan, 

seperti: 

1. Spesifik untuk proyek branding/rebranding:  

o Untuk proyek rebranding, apakah yang klien ingin ubah/tidak puas dari brand 

yang ada? 

o Apakah mereka memiliki branding guideline? 

o Apakah mereka membutuhkan kita untuk memproduksi branding guideline? — 

jika ya, maka kita perlu melibatkan penulis kopi (copy writer) dalam proyek ini. 

2. Untuk proyek desain logo, apakah logonya berupa tipografi, gambar atau keduanya? 

3. PAHAM TENTANG BRAND/PRODUK 

Pertanyaan yang diajukan disini adalah: who are they & what they do? —terjemahan: 

apakah obyeknya (disini berarti brand/produknya) dan apa kegunaannya? 
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Semakin detail informasi yang kita ketahui tentang brand/perusahaan dan tujuan bisnisnya, 

semakin kenal dan semakin mudah memahami klien. 

Tentunya informasi disini adalah yang berhubungan dengan pekerjaan desain ya, kita tidak 

perlu mengetahui laporan keuangannya hehe. 

Peroleh informasi yang selengkap-lengkapnya tentang jati diri brand/produk: 

1. cerita/sejarah/filosofi produk 

2. branding guidelines 

3. tagline, kreatif element-nya 

4. hal yang menarik/menjual (key selling point) dari brand/produknya, jika dirasa perlu 

5. kompetitor, apa yang mereka kagumi/sukai atau tidak suka 

6. referensi desain yang mereka sukai, dan kenapa 

Informasi detail khusus untuk proyek branding/rebranding: 

1. rencana atau tujuan brand/produk kedepannya– terutama dalam proyek rebranding 

2. sejarah/latar belakang kenapa brand ini ada, jika dirasa perlu (terutama kalau 

foundernya orang terkenal atau sejarahnya cukup fenomenal, eg. Virgin Air) 

4. KENALI TARGET AUDIENCE 

Siapakah yang menjadi target dari desain yang akan kita hasilkan? Siapa target audience-

nya? 

 Target audience untuk pekerjaan desain bisa jadi lebih spesifik — karena desain 

dibuat untuk keperluan dan konteks yang lebih spesifik, seperti social media 

campaign/brosur/billboard/banner ads digital, dst. 

 Jadi pastikan deskripsi target audience disini adalah target audience yang sesuai 

untuk pekerjaan desainnya. 

Beberapa kategori yang biasa digunakan untuk mendeskripsikan audience adalah: 

1. usia dan gender/jenis kelamin 
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2. status ekonomi, acuan yang sering digunakan adalah Socio economic status/SES 

3. interest/ketertarikan/hobi/passion/habit 

5. TONE OF VOICE DAN KEY MESSAGE 

Tone of voice berkaitan erat dengan pencitraan yang ingin dicapai brand di mata 

konsumen/target audience-nya. 

Kesan apa yang ingin ditinggalkan kepada audience? 

Bagi yang kurang familiar dengan istilah tone of voice, bahasa yang sederhananya adalah 

tentang kepribadian/karakteristik brand ketika diperkenalkan dan ingin disampaikan ke 

target audience. 

Jika masih sulit untuk mendeskripsikannya, minta klien memberikan referensi 

desain/gambar/website yang mereka sukai atau merepresentasikan brand-nya. 

6. METODE ATAU ALUR KERJA 

Bekerja sama akan lebih mudah dan efektif jika kedua pihak saling memahami bagaimana 

alur kerja masing-masing. 

Oleh karena itu di sini komunikasi diharapkan berjalan 2 arah. 

DESAINER harus menjelaskan: 

1. menjelaskan alur kerja desain 

2. materi yang dibutuhkan dari klien, seperti logo, kode warna. 

3. jika ada materi atau komponen yang harus diproduksi secara terpisah/outsourcing, 

informasikan hal ini kepada klien terutama jika membutuhkan waktu dan budget 

extra. 

4. tahapan kerja dan keterlibatan klien di tahapan tertentu, termasuk revisi 

5. hasil akhir yang mereka peroleh 

Untuk kelancaran komunikasi dalam proyek, mintakan informasi ini dari KLIEN: 

 siapa person-in-charge (PIC), yang menjadi sumber informasi selama proyek 

berlangsung. 

 bentuk presentasi desain yang disampaikan: prototipe, mock up, powerpoint, print 

out, atau bentuk file digital sudah cukup 

https://en.wikipedia.org/wiki/Socioeconomic_status
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 siapa yang menjadi pengambil keputusan atau bagaimana keputusan diambil 

terutama terkait approval . 

 Mulai bekerja setelah klien mengirimkan persetujuan resmi untuk bekerja sama, 

dalam bentuk kontrak kerja, surat perintah kerja, Purchase order/PO, atau lainnya. 

 Selalu kirimkan rekap dari hasil diskusi/pertemuan dari setiap tahapan dan revisi 

dan minta tanggapan dari klien. 

 Pastikan budget, deadline dan termin pembayaran (term of payment) disetujui 

kedua pihak. 
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Tujuan Pembelajaran 

7. Peserta Didik mampu membedakan Desain Vector & Bitmap 

8. Peserta Didik Mampu mengoperasikan salah satu perangkat lunak desain grafis 

vector 

 

 

 

Mengoperasikan Piranti Lunak 

Desain Grafis 

 

 

 

 

 

Desain Vector  

Secara umum, dalam dunia desain grafis kita dapat membedakan 2 (dua) ranah besar ragam 

desain, yaitu desain berbasis vector (vector based design) dan desain berbasis bitmap 

(bitmap based design). 

Mengapa musti ada pembedaan semacam ini? Mungkin Anda bertanya demikian. Well, 

alasannya adalah, karena memang software desain yang ada menggunakan sistem yang 

berbeda berdasarkan dua kategori di atas. Desain berbasis vector menggunakan 

perhitungan matematis dalam menentukan dan menampilkan obyek-obyek penyusun 

sebuah desain. Perhitungan matematis ini ini meliputi berbagai parameter penyusun suatu 

obyek, seperti posisi koordinat, tebal tipisnya garis luar (outline), warna isi (fill) obyek dan 

berbagai parameter lain. Sehingga untuk melakukan pengeditan terdapat obyek desain 

berbasis vector sama artinya dengan mengedit parameter penyusunnya. 

Sebagai konsekuensinya, desain berbasis vector mempunyai keunggulan di mana Anda bisa 

mengubah bentuk, ukuran dan berbagai parameter lainnya secara bebas tanpa khawatir 

akan terjadi penurunan kualitas tampilan maupun kualitas cetaknya. Anda akan temukan 

tampilan yang senantiasa tajam, jelas dan bagus pada obyek desain berbasis vector. Sifat 

desain vector yang senantiasa terlihat tajam ini disebut dengan resolution independent 

(resolusi bebas). 
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Vector lebih cocok untuk membuat obyek desain berbetuk geometris, seperti kotak, 

lingkaran, elips dan poligon. Akan relatif sulit untuk membuat desain dengan tekstur 

kompleksi seperti pada foto menggunakan model vector ini. Oleh karenanya, desain vector 

lebih banyak digunakan untuk membuat desain-desain yang menekankan pada soliditas 

bentuk dan warna, serta fleksibilitas ukuran , seperti desain logo, letterhead, kartun dan 

sebagainya. 

Perhatikan Gambar 1.1. di bawah ini untuk lebih jelasnya. 

 

Gambar 1.1. Obyek desain vector bersifat resolution independent 

Untuk bisa membuat desain vector, Anda musti menggunakan software desain vector. Ada 

beragam pilihan yang bisa digunakan, seperti Adobe Illustrator, Adobe Freehand, CorelDraw 

dan sebagainya. 

Jadi, sekiranya Anda berminat dan berniat untuk serius terjun di bidang ini, maka Adobe 

Illustrator adalah pilihan terbaik yang Anda punya. Ok? 

Desain Bitmap 

Tipe desain satu lagi adalah desain bitmap, atau umum pula disebut desain raster (raster 

based design). Bitmap atau raster adalah desain yang tersusun dari obyek-obyek titik—

disebut dot/pixel—dengan warna beragam yang tersusun pada lajur-lajur vertikal dan 

horisontal—disebut grid—dengan tingkat ketajaman tertentu, disebut resolusi. 

Bayangkan desain bitmap sebagai kumpulan titik-titik dalam sebuah mosaik, di mana ketika 

mosaik tersebut dilihat pada jarak tertentu, maka Anda akan dapati sebuah gambar/image 
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yang diinginkan. Namun, sekiranya Anda memperbesar tampilannya, maka Anda akan 

dapati titik-titik penyusun image tersebut mulai terlihat—umum disebut sebagai efek jaggy 

(pecah). 

Sifat desain bitmap yang terlihat pecah semacam ini disebut sebagai resolution dependent 

(resolusi tak bebas). Tipe desain bitmap sangat cocok digunakan untuk menampilkan image 

dengan ragam warna yang banyak, tekstur beragam serta tak begitu membutuhkan 

fleksibilitas ukuran, seperti foto. 

Simak pada Gambar 1.2. berikut ini untuk lebih jelasnya. 

 

Gambar 1.2. Obyek bitmap yang bersifat resolution dependent 

Untuk membuat atau mengedit obyek desain bitmap, maka Anda membutuhkan software 

pengolah image/image editing, seperti Adobe Photoshop, Jasc PaintShop Pro, Corel 

Photopaint dan sebagainya. 

Jika di atas disebutkan bahwa pengeditan obyek vector sama artinya dengan mengedit nilai-

nilai parameter penyusun obyek vector tersebut, maka pengeditan image bitmap adalah 

mengedit dot penyusun image bersangkutan. Karena fokus kita pada buku ini lebih 

mengenai desain vector, maka kita tak akan menyinggung mengenai image bitmap. 

Kegunaan Desain Vector 

Hal apa yang mendorong seseorang untuk mau mempelajari sesuatu adalah kegunaan dari 

hal tersebut. Begitu juga saat Anda akan mempelajari desain vector ini, tentunya terlintas 

dalam benak Anda, apa sih manfaat mempelajari keahlian yang satu ini. Sekiranya penulis 
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pandang amat penting untuk sedikit membeberkan berbagai kegunaan yang bisa Anda 

peroleh dari pelajaran kita akan desain vector, baik bagi Anda yang memang serius 

menekuni bidang desain grafis, atau bagi Anda yang hanya hobi saja. 

Berikut adalah beberapa hal yang bisa diperoleh dari kemampuan desain vector: 

1. Desain vector banyak digunakan untuk membuat desain-desain yang membutuhkan 

soliditas bentuk, warna dan fleksibilitas ukuran, seperti logo dan letterhead. 

Dengan menguasai desain vector, Anda akan lebih mampu dalam merancang, 

membuat atau mengedit desain logo, letterhead dan sebagainya.  Di mana, 

perancangan dan pembuatan logo adalah salah satu kerja kreatif yang pasti akan 

Anda temui saat berkecimpung dengan dunia desain grafis. 

2. Desain vector memungkinkan Anda untuk lebih mengeksplorasi kemampuan Anda 

dalam membuat bentuk, memilih warna, mengatur tata letak (layout) dan berbagai 

elemen-elemen dasar desain lainnya. Semakin sering Anda melatih membuat desain 

vector, semakin mahir pula Anda dalam membuat sebuah desain. 

3. Desain vector memungkinkan Anda menampilkan identitas diri Anda secara personal 

dalam karya desain yang Anda kerjakan. Mengapa demikian? Hal ini karena sebuah 

desain vector merupakan sebuah obyek ilustrasi, di mana tak akan pernah ada dua 

ilustrasi yang bisa benar-benar sama. Sentuhan artistik desainer di belakangnya akan 

sangat kuat mewarnai tampilan obyek vector bersangkutan. Sehingga, kita akan bisa 

mengindentifikasikan sebuah karya dengan sosok desainer tertentu. Di sinilah 

tempat Anda menunjukkan jati diri. 

4. Desain vector memungkinkan adanya eksplorasi terhadap bentuk dan elemen-

elemen desain yang sekiranya tak bisa ditemukan pada pengeditan image bitmap. Di 

mana, sebuah ilustrasi memberi seorang desainer keleluasaan untuk membentuk 

dan mengeditnya, sesuai dengan imajinasi dan teknik yang dimilikinya. Batasan yang 

ada hanyalah soal kreatifitas. 

5. Desain vector memungkinkan Anda menciptakan karya yang orisinal dan khas 

dengan sentuhan personal. Inilah sekiranya alasan terkuat mengapa Anda perlu 

mempertimbangkan untuk berkarya lewat desain vector. Karena melaluinya Anda 

bisa tunjukkan kepada dunia siapa Anda sebenarnya. 
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CorelDraw 

 

MEMBUAT OBYEK DASAR 

Banyak jenis obyek dasar yang bisa kita buat dalam CorelDraw dengan berbagai tool 
yang sudah tersedia pada 

tool box. 
 
 
MODUL 1 

 
Membuat Berbagai Macam Garis 

1. Aktifkan freehand Tool  lalu arahkan pointer pada halaman. 
2. Klik di sembarang tempat, lalu klik ditempat yang lain. Perintah ini untuk    

membuat satu garis lurus. 
3. Klik drag seperti layaknya kita pegang pensil untuk membuat garis bebas. 

 
 

 
 Macam‐macam garis menggunakan freehand tool. 

 
 

4. Aktifkan Bezier tool  lalu klik disuatu tempat pada halaman, lalu klik 

ditempat lain, lalu klik di tempat lain lagi. Tool ini untuk membuat garis 

dengan beberapa node. Untuk mengakhiri pembuatan garis jenis ini, lakukanlah 

double‐click. 
 

5. Masih menggunakan Bezier tool       , lakukan perintah click‐drag di 

sembarang tempat. Click‐drag di tempat lain. Lakukan perintah ini beberapa 

kali. Langkah ini adalah untuk membuat garis melengkung. 

 

 
Macam‐macam garis menggunakan Bezier 

Tool. 
 

6. Aktifkan Artistic Media Tool  maka pada Property Bar akan muncul seperti 
berikut: 

 
 

 
Property Bar untuk Artistic Media Tool. 

 
 

7.  Properti diatas berfungsi untuk memilih jenis garis artistik yang ingin kita buat. 
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Macam‐macam garis tersebut antara lain brush, sprayer, calligraphic, dan 

pressure. 

8. Pilihlah salah satu jenis garis yang ingin anda buat, lalu pilihlah model garis 

tersebut pada menu‐menu yang terdapat disebelah kanannya. 

9.    Untuk membuat jenis garis yang sudah kita pilih, lakukan click‐drag di area 
halaman. 

 
 

 
 Artistic Media Line. 

 
 

10.  Aktifkan Pen Tool  lalu klik di area halaman untuk membuat garis. Click‐

drag untuk membuat garis lengkung. Hasil dari Pen Tool hampir sama seperti 

menggunakan Bezier Tool. 

 
 Pen line. 

 
 

11.  Aktifkan Polyline Tool  lalu klik di area halaman untuk membuat garis. 

Click‐drag untuk membuat garis lengkung. Hasilnya sama seperti Bezier dan pen 

line. 
 
 
 
 

 
Polyline. 

 
 

12.  Aktifkan 3 Point Curve Tool  lalu klik di area halaman. tool ini untuk 
membuat garis lengkung. 

Hasilnya bisa kita perhatikan seperti berikut: 
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3 point curve line. 

 
 

13.  Buatlah beberapa obyek misalnya lingkaran, persegi panjang, belah ketupat. 

14.  Aktifkan Interactive Connector Tool  lalu buatlah garis penghubung 

antara obyek‐obyek yang sudah dibuat sebelumnya. Anda bisa membuat garis 

penghubung antar obyek seperti gambar berikut: 

 

 
Interactive Connector Tool. 

15.  Kita bisa memberikan informasi tambahan berupa ukuran dari suatu obyek, 

misalnya panjang, lebar, sudut kemiringan. Fasilitas tersebut terdapat pada 

Dimension Tool . 

16.  Buatlah sebuah obyek menggunakan Basic Shape Tool. 

17.  Aktifkan Dimension Tool , maka pada property bar akan muncul menu seperti 
berikut: 

 
 

 
Dimension Tool Property. 

 
 

18.  Pilihlah jenis dimension line yang diinginkan. Arahkan pada obyek yang ingin 

diberi keterangan, lalu klik, klik diujung lainnya, lalu arahkan ke tengah (antara 

ujung satu dengan lainnya) dan klik untuk memberikan angka yang dimaksud. 
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Dimension line. 

19.  Aktifkan smart drawing tool  , lalu click‐drag di area halaman. garis 

yang dibuat akan secara otomatis mengurangi jumlah node sehingga kelihatan 

lebih halus. 

 

 
 Smart Drawing line. 

 

20.  Aktifkan rectangular tool  lalu buatlah persegi panjang di area halaman 

(a). jika ingin membuat bujur sangkar, klik sambil menekan tombol Ctrl (b). 

Jika obyek persegi panjang atau bujur sangkar ingin langsung dimiringkan 

maka gunakan 3 point rectangular  (c). 

 

 
Rectangular. 

 
21.  Aktifkan  ellips  tool   lalu  buatlah  obyek  elips  dengan  cara  click‐drag  (a).  

Jika  ingin  membuat lingkaran dengan diameter sama, sambil menekan tombol 

click‐drag + Ctrl (b). Jika lingkaran langsung dimirinkan, gunakan 3 point ellips 

tool  (c). 

 

 
 

Ellips. 
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22.  Aktifkan Graph Paper tool , lalu pada property bar akan muncul menu seperti 
berikut: 

 
 

 
Graph property bar. 

23.  Tentukan jumlah baris dan jumlah kolom pada peroperty bar seperti gambar 

diatas. Jika sudah, click‐ drag di area halaman. maka akan muncul table dengan 

jumlah baris dan kolom yang sudah ditentukan sebelumnya. Gunakan perintah 

click‐drag + Ctrl untuk membuat tabel dengan ukuran sama sisi. 

 

 
Graph Paper. 

 
 

24.  Aktifkan polygon tool  , anda perhatikan pada property bar untuk 

menentukan jumlah sudut yang kita  inginkan.  Click‐drag  pada  area  halaman  

untuk  membuat  polygon  yang  kita  inginkan.  Untuk membuat polygon sama 

sisi, lakukan click‐drag sambil menekan tombol Ctrl. Polygon tool ini juga bisa 

digunakan untuk membuat obyek bintang, caranya adalah dengan 

mengaktifkan icon star  pada property bar. Hasilnya bisa anda lihat seperti 

berikut: 

 

 
Obyek polygon. 

 
 

25.  Aktifkan spiral tool  lalu tentukan variable‐variabel yang terdapat pada 

property bar. Kita bisa menentukan banyaknya spiral serta orientasinya. 

 
Property spiral. 

 
 

26.  Untuk membuat spiral sama sisi maka lakukan perintah click‐drag + Ctrl. 
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MENYIMPAN DOKUMEN 

1.    Klik menu File> Save As. Maka akan muncul window seperti berikut: 
 

2. Klik pada Save in untuk menentukan letak penyimpanan. Klik folder yang 

terdapat di bawahnya untuk mencari tempat yang diinginkan. 

3.    Ketik nama file pada File name. 

4.    Klik 

tombol save. 

Catatan: 

Jika file yang kita buat akan dibuka pada komputer lain yang mempunyai program 

CorelDraw dengan versi dibawahnya, maka anda bisa menyesuaikan versi pada combo 

box Version yang ada disebelah kanan kotak dialog Save As. File yang disimpan di versi 

yang lebih tinggi tidak dapat dibuka pada CorelDraw versi lebih rendah. Namun file 

CorelDraw yang disimpan di versi rendah bisa dibuka pada CorelDraw versi lebih tinggi. 

 

MEMBUKA FILE 

1.    Klik menu file > Open. Pada Look in diarahkan ke drive dimana kita menyimpan 
file. Carilah folder ‐‐ 

yang berada di bawah Look in‐‐ tempat kita menyimpan file. 

2.    Aktifkan file yang ingin kita buka. 
3.    Klik Open. 

 
Catatan: 

Aktifkan  ceck  box  Preview  untuk  melihat  desain  sebeum  dibuka,  ini  untuk  

memastikan  apakah  gambar tersebut yang akan dibuka. 
 
 
 
 
MODUL 2 
 
 
 

MENGUBAH BENTUK OBYEK 

Obyek‐obyek dasar yang sudah dibuat pada bab sebelumnya, sekarang akan kita 
edit menggunakan 

Shape Tool , knife tool , eraser tool , smudge tool , dan roughen tool . 

Editing Dengan Shape Tool 

Jika obyek yang akan diedit merupakan obyek bidang seperti persegi panjang, 

lingkaran, polygon dan lain‐lalin, maka sebelum melakukan editing terlebih dahulu 

obyek tersebut dikonversi ke kurva. Cara untuk konversi adalah dengan memilih 

menu Arrange > Convert To Curves. Bisa juga menggunakan shortcut Ctrl+Q.  

 

Property bar akan muncul menu seperti berikut: 
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Gambar 40. Property 

shape tool. 
 
 

12.  Klik pointer ke garis tepi obyek sehingga muncul lingkaran hitam kecil. 

13.  Klik ikon add node  pada property bar. Perintah tersebut untuk menambah node 
baru pada obyek. 

14.  Klik pada salah satu node yang lain, lalu klik delete node  . Perintah ini 

untuk menghapus node yang aktif. Anda bisa memanipulasi bentuk obyek 

sesuai kebutuhan. 

 

 
Editing shape. 

 
 
Catatan: 

  Untuk menambah dan mengurangi node dengan cepat, gunakan perintah double‐
click. 

 
 
Memecah dan Menggabung Kurva 

1.    Aktifkan obyek dengan shape tool, lalu klik pada segmen (garis tepi obyek). 

2.    Klik ikon Break Curve . Perintah ini untuk memecah segmen menjadi dua bagian 
segmen baru. 

 
Memecah kurva. 

     
 

3.    Aktifkan kembali kedua node yang sebelumnya di pecah. 

4.    Klik ikon join two node . Perintah ini untuk menggabungkan 2 node yang 
terpisah. 

 
 
 
 



 
Modul Desain Grafis Level III KKNI      59 
 

 
 

 
 

 
Menggabung node. 

 
Melengkungkan dan meluruskan segmen 

1.    Aktifkan salah satu obyek menggunakan shape tool. 

2.    Klik pada segmen sampai muncul lingkaran. 

3.  Klik ikon Convert Line To Curve  , lalu Click‐drag pada segmen tadi untuk 

melengkungkan segmen tersebut. Anda perhatikan maka akan muncul dua 

control point yang berfungsi untuk mengatur kelengkungan segmen. Sehingga 

untuk melengkungkan segmen bisa langsung pada segmen tersebut maupun 

pada control point. 

 
Konversi segmen lurus ke segmen 

lengkung. 
 
 

4.    Jika ingin mengembalikan menjadi segmen lurus, maka aktifkan segmen lengkung 
tersebut. 

5.    Klik ikon Convert Curve To Line . 
 
 
Smooth Node, Cusp Node, Symmetrical Node 

1.    Buatlah obyek persegi panjang menggunakan Rectangular Tool. 

2.    Klik menu Arrange > Convert To Curves untuk mengubah obyek bidang menjadi 
kurva. 

3. Aktifkan shape tool, lalu klik di segmen (garis tepi obyek) sehingga muncul 

node baru pada garis yang di klik tersebut. 

4.    Klik ikon Convert Line To Curve , lalu double‐click pada sagmen tadi sehingga 
muncul node baru. 

5.    Click‐drag node tersebut kea rah yang diinginkan. Kita perhatikan disana muncul 
control point. 
6. Geserlah salah satu control point tersebut ke sembarang arah. Jika salah satu 

control point digeser, maka control point yang berseberangan juga akan ikut 
bergeser tegak lurus. Node dalam keadaan seperti ini disebut smooth node. 
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Perubahan posisi control point. 

 
 
 

7. Klik ikon Make Node Cusp        pada property bar. Lalu geserlah salah satu 

control point ke sembarang arah. Kita perhatikan maka control point yang 

berseberangan tidak ikut berubah posisinya. Keadaan seperti ini disebut Cusp 

Node. 

 

 
Cusp Node. 

 
 

8.    Klik ikon Make Node Smooth  pada property bar. Perintah ini untuk 
mengembalikan agar kedua 

control point menjadi satu arah kembali. 
 
 

 
Smooth Node. 

9. Klik ikon Make Symmetrical Node  pada property bar. Perintah ini adalah 

untuk membuat jarak kedua control point selalu sama terhadap node. 

 

 
Symetrical node. 

 
 

Membuka, Menutup dan Memisah Segmen 

1.    aktifkan obyek yang telah diedit sebelumnya. Pastikan masih aktif pada shape tool. 

2.    Double‐click pada salah satu segmen untuk membuat node baru. 

3.    Klik break curve untuk memecah segmen. Geser node tersebut ke sembarang arah 
sehingga terpisah. 

4. Aktifkan kedua node yang dipisahkan tadi, lalu klik ikon Extend Curve To Close 

. Perintah ini adalah untuk menutup kurva yang terbuka. 
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Menutup kurva. 

 
 
 
 

5.    Klik tombol Undo sampai obyek kembali menjadi kurva terbuka. 
 
 
 

6. Klik ikon auto‐close curve      . Perintah ini bisa dilakukan tanpa mengaktifkan 

kedua node yang akan ditutup. Anda bandingkan hasilnya dengan perintah 

Extend Curve To Close. 

 

 
 Auto‐Close Curve. 

 
 

7.    Click‐drag node yang masih kelihatan menyatu untuk memisahkan obyek. 

8.    Aktifkan semua node pada salah satu obyek. 

9. Klik ikon Extract Subpath  . Perintah ini adalah untuk memisahkan kedua 

obyek menjadi obyek yang tidak berkaitan langsung. Sekarang coba aktifkan 

salah satu obyek tersebut, obyek yang lain 
tidak akan ikut aktif walaupun tadinya menjadi satu kesatuan. 

 
 
 
 
 
 
 
 
 
 
 
 

Memisah obyek dengan extract 
subpath. 

 
 
Scaling, Rotating, Aligning Node. 

Kita bisa memanipulasi bentuk obyek dengan cara menyeleksi sebagian node untuk 
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dilakukan operasi scaling, 

rotating, aligning. 

1.    Buatlah obyek baru berupa anak panah tiga arah menggunakan Arrow Shape Tool. 

2.    Ubahlah obyek menjadi kurva dengan perintah Ctrl+Q. 

3.    Aktifkan shape tool, lalu aktifkan node yang membentuk panah keatas. 

4. Klik ikon  Stretch and Scale Nodes, maka akan muncul node berjumlah 8 

yang berfungsi untuk membesarkan dan mengecilkan node yang terseleksi. 

5.    Click‐drag pada salah satu node tersebut sesuai arah panah pointer (keluar atau 
kedalam). 

 
Mengecilkan sebagian obyek dengan 

node. 
 

6.    Aktifkan beberapa node yang membentuk anak panah ke kanan. 
 

7. Klik ikon Rotate and Skew, maka akan muncul node 8 anak panah dua arah 

yang berfungsi untuk memutar atau skew beberapa node yang aktif tersebut. 

8.    Click‐drag pada salah satu node yang berada di pojok untuk memutar. 

9.    Click‐drag pada salah satu node panah horizontal atau vertical untuk melakukan 
skewing. 

 
Rotate dan skew nodes. 

 
10.  Aktifkan beberapa node yang membentuk panah ke kiri, lalu klik ikon Align 

Node . Maka akan muncul kotak diaog seperti berikut: 

 
Node Align dialog. 

 
11.  Terdapat dua perataan yaitu horizontal dan vertical, kita bisa mengaktifkan salah 
satu atau keduanya. 
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Untuk sekarang aktikan Align Horizontal lalu klik OK. 

 

Align Node. 
 
 

MOD
UL 3 

 
 
 
MODUL 3 

 
MENYUSUN, MENATA, MENGATUR, MENGUBAH OBYEK 

 

Pada bab  sebelumnya kita sudah membicarakan  tentang editing obyek 

dasar. Pada pembahasan tersebut adalah cara mudah dan cepat untuk melakukan 

editing dasar seperti pengubahan ukuran, rotasi, menggeser obyek, skew obyek, 

pencerminan obyek. Pada pembahasan kali ini, kita akan mengenal perintah‐ perintah 

tersebut melalui menu Arrange pada menu bar. 

Selain itu, pada bab ini juga akan membahas semua fasilitas pengaturan obyek 
yang terdapat pada menu 

Arrange. Misalnya mengenai perataan dan distribusi, ordering, grouping, 
combining dan shaping. 

 
 

Transformasi Obyek 

Trasformasi pada latihan kali ini akan mengoptimalkan fungsi Window Docker 

Transformation yang terdapat disebelah kanan window. Kelebihan dari fungsi ini 

adalah kita bisa memberikan ukuran yang tepat dan akurat pada setiap transformasi 

obyek. 

menu Arrange > Tranformation, maka akan muncul Window Docker seperti berikut: 

 
Window Docker Transformation. 

 
 

Position  untuk mengatur jarak pergeseran obyek. Pergeseran bisa dilakukan secara 
horizontal, vertical maupun kombinasi horizontal dan vertical. 
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 Rotate . Untuk memutarkan objek 

 Scale and Mirror  Un t u k  m emp er b e sa r  d an  me n ce rm in k an  ob j e k  

 Size  U n t u k  m e m p e r b e s a r  a t a u  m e m p e r k e c i l  u k u r a n  o b j e k  

  Skew    menghasilkan memiringkan objek 

 
Catatan: 

Tombol Apply , proses transformasi pada objek 

Tombol Apply  To Duplicate, proses transformasi pada objek sambil mengcopy 
 
 
PERATAAN DAN DISTRIBUSI OBYEK 

 Arrange -  Align and Distribute  
 
 
 
MENGATUR POSISI DEPAN/BELAKANG OBYEK 

Arrange > Order > To Front. Perintah ini untuk meletakkan obyek berada di posisi 

paling Atas 

Arrange > Order > To Back. Perintah ini untuk meletakkan obyek berada pada 

posisi tumpukan paling belakang. 

Arrange > Order > Forward One. Perintah ini untuk menggeser posisi obyek satu 

langkah ke depan. 

Arrange > Order > Back One. Perintah ini untuk menggeser posisi obyek satu 

langkah ke belakang. 

 Arrange > Order > In Front of…  Perintah  ini  untuk meletakkan obyek  di depan obyek 
yg ditunjuk. 
 Arrange > Order > Behind… . Perintah ini untuk meletakkan obyek di belakang obyek yg 
dipilih. 
 Arrange > Order > Reverse Order. Perintah ini untuk menukar posisi dua obyek 

yang aktif. 

 
Catatan: 

 Untuk mempercepat perintah ordering obyek yang sering digunakan, 

gunakan shortcut pada table berikut: 

 
 
 

GROUPING OBYEK 

Arrange > Group. Perintah ini adalah untuk menggabungkan beberapa obyek. 

Jika kita geser obyek tersebut maka akan selalu bergeser bersama dan 

menyatu. 
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 Arrange > Ungroup. Perintah ini untuk memisahkan obyek yang di group. 

Arrange > Ungroup All. Perintah ini berfungsi untuk memisahkan obyek yag 

memiliki grouping bertingkat. 

Catatan: 

  Untuk mempercepat perintah, kita bisa menggunakan shortcut yaitu: 

  
 

  Kita juga bisa menggunakan perintah grouping yang terdapat pada Property bar 
yaitu: 

 
 
 
 

COMBINING OBYEK 

Arrange  >  Combine.  Perintah  ini  adalah  untuk menggabung obyek  menjadi  

satu  obyek baru. Anda bisa  mengeditnya  lebih  lanjut  menggunakan Shape 

Tool. 

       Jika ingin memisahkan kedua obyek tersebut, gunakan perintah Arrange > 
Break Curve Apart. 

 
 

MENGUNCI OBYEK 

 Aktifkan salah satu obyek, lalu klik menu Arrange > Lock Object. Perintah ini 

untuk mengunci posisi obyek. Hal ini untuk memudahkan editing jika obyek 

yang kita gambar banyak dan komplek. Agar obyek tidak bergeser posisinya 

maka bisa kita kunci. Jika obyek yang terkunci di klik, maka node akan muncul 

berubah menjadi gembok seperti gambar berikut: 

     menu Arrange > Unlock Object. Perintah ini untuk menonaktifkan kunci 

sehingga obyek dapat kembali diedit. 

 
Catatan: 

 Jika terdapat banyak obyek yang terkunci, maka kita bisa menonaktifkan kunci 

tersebut dengan sekali perintah yaitu klik menu Arrange > Unlock All Object. 
 
 

SHAPING 
OBJECT 

Shaping adalah kumpulan perintah untuk memanipulasi bentuk obyek dengan cara 

menyinggugkan posisi satu obyek dengan obyek lain. Operasi shaping yang bisa kita 

lakukan antara lain weld, trim, intersect, simplify, front minus back, dan back minus 

front. 

 
Arrange > Shaping > Weld. Perintah ini untuk menggabungkan semua obyek 
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menjadi satu dan membentuk obyek baru. Perintah shaping menghilangkan 

garis‐garis yang bersinggungan yang berada di dalam area obyek, sehingga 

hasilnya hanya outline dari gabungan obyek tersebut. 

 
Weld. 

 
 

Arrange  >  Shaping  >  Trim.  Perintah  ini  untuk  memotong  obyek  menggunakan  

obyek lainnya. 

 
Trim. 

 
 
Catatan: 

 Obyek yang diaktifkan pertama adalah sebagai pemotong, sedangkan yang 

diaktifkan kedua adalah obyek yang dipotong. 
 
 
 

Arrange  >  Shaping  >  Intersect.  Perintah  ini  untuk  membentuk  obyek  baru  

dari  hasil perpotongan dua obyek yang bersinggungan. 

 
 Intersect. 

 
 
 

Arrange > Shaping > Simplify. Perintah sama seperti trim, namun pemotongan 
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dilakukan terhadap semua obyek secara bersamaan. 

Berikut ini menunjukkan obyek hasil Simplify dan obyek tersebut di uraikan: 
 
 
 

 
Arrange > Shaping > Front Minus Back. Perintah ini untuk mengubah bentuk 

obyek dengan cara mengurangi obyek yang ada di depan dengan obyek yang 

ada di belakangnya. 
Contoh hasil berikut ini dengan asumsi bahwa obyek elips berada di depan 

obyek persegi panjang. 

 
Arrange > Shaping > Back Minus Front. Perintah ini untuk mengubah bentuk 

obyek dengan cara mengurangi obyek yang ada di belakang dengan obyek yang 

ada di depannya. 

  Contoh hasil berikut ini dengan asumsi bahwa obyek elips berada di depan 
obyek persegi panjang.

 
Arrange > Shaping > Shaping. Perintah ini untuk memunculkan Window Docker 

Shaping yang berisi perintah‐perintah yang sama dengan yang kita bahas 

sebelumnya, perintah tersebut yaitu weld, trim, intersect, simplify, front minus 

back, dan back minus front. 
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Window docker weld. 

 
 

Dari window docker shaping  terdapat tambahan parameter yang bisa kita berikan 

yaitu Leave Original, parameter ini berfungsi untuk meninggalkan obyek asli 

atau tidak menghilangkannya setelah diproses. 

Catatan: 

  Kita bisa menggunakan menu shaping melalui Property bar seperti gambar berikut: 

  
 

KONVERSI OBYEK KE KURVA 

Ketika kita membuat obyek dasar berupa bidang misalnya persegi panjang, bujur 

sangkar, lingkaran, polygon, basic shape dan lain‐lain, kita bisa melakukan editing 

shape secara terbatas. Menu Arrange > Convert To Curve digunakan untuk 

mengkonversikan objek non kurva menjadi objek kurva 

 

Arrange > Convert Outline To Object. Perintah ini untuk mengubah outline 

(garis tepi) menjadi obyek baru. Kita bisa melakukan editing seperti obyek 

lainnya. Jika outline tidak dikonversi ke obyek maka hanya bisa dilakukan 

editing outline saja. 
 

Arrange > Close Path > Closest Nodes with Straight Lines. 

Perintah ini untuk menutup beberapa kurva yang terbuka menjadi satu 

kurva tertutup. Syaratnya adalah jika beberapa kurva tersebut merupakan satu 

kesatuan obyek. 

Arrange Close Path > Closest Nodes with Curvy Lines. Perintah ini sama seperti 

perintah sebelumnya, namun garis yang menutup kurva berbentuk 

melengkung. Kita bisa bedakan hasil kedua perintah diatas melalui gambar 

berikut: 

 
Arrange > Close Path > Start To End with Curvy Line. Perintah ini sama seperti 
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perintah sebelumnya, namun garis yang menutup obyek berupa garis lengkung. 

   
MODUL 4 
 
 

 

PENGATURAN PADA TEKS 

Pada menu TEXT husus untuk pengaturan teks, baik teks artistik maupun teks 
paragraph. 

 

Text – Character Formating 

Pilihan ini untuk memformat teks secara umum (Font, Size,  Style dan Effect Font) 

 

Text – Paragraph Formating 

Pilihan ini untuk memformat paragraph (alignment, spacing, Indent dan text direction) 

 

Text – Tab 

Untuk memasang tabulasi pada teks paragrap 

 

Text – Column 

Untuk membentuk teks paragrap column 

 

Text – Bullets 

Untuk memformat bullet atau simbol paragrap teks 

 

Text – Drop Caps 

Untum memformat drop pada teks paragrap 

 

Text – Edit Text (Ctrl + Shift + T) 

Untuk melakukan editing teks 

 

Text – Insert Character 

Untuk menyisipkan simbol character 

 

Text -  Fit Text To Path 

Fit Text To Path adalah suatu perintah untuk menempatkan teks menepati alur path 
objek. Teks harus berupa teks artistik dan objek path bisa objek path terbuka atau path 
tertutup. 

 

Contoh :  
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Cara kerja : 

1. Buat teks dan Pathnya  
2. Aktifkan teks dengan Pathnya 
3. Pilih menu Text – Fit Text To Path 
4. Teks akan menempel pada path objek 
5. Lakukan pengaturan pada properti jika diperlukan, seperti Text Orientation 

(orentasi teks), Distance From Path (mengatur jarak antara teks dg path), 
Horizontal Offset (untuk mengatur jarak secara horizontal) dan Mirror Text 
(untuk membalikan posisi huruf baik horizontal ataupun vertical)  

 

Catatan : Untuk memisahkan objek teks dengan pathnya, maka pilih Arrage – Break A 
Path 

 

Text – Align To Baseline 

Untuk mengatur perataan node teks supaya sejajar 

 

Text – Straighten Text 

Supaya posisi node objek kembali ke bentuk asal (normal)  

 

 

SPECIAL EFFECT 
 
 

Efek khusus (special effect) tersebut meliputi transformasi obyek, efek kontur, 

distorsi obyek, obyek berbayang, efek tiga dimensi, efek transparansi, efek perspektif, 

lens, power clip, dan lain‐lain. Perintah‐perintah tersebut terdapat pada Tool Box dan 

juga pada menu bar Effect. Khusus untuk tool Special Effect yang terdapat pada tool 

box. 

 

 

Effects – Blend 
Blend merupakan spesial efek Transformasi Obyek baik bentuk maupun warna 
 

1.    Buatlah obyek bujur sangkar menggunakan Rectangular Tool. 

2. Aktifkan Pick Tool lalu berikan warna dengan memilih salah satu warna 

pada Color Palette yang terdapat di sebelah kanan window. 

3.    Buatlah obyek segi lima menggunakan Polygon Tool. 

4. Aktifkan Pick Tool lalu berikan warna dengan memilih salah satu warna 

pada Color Palette yang terdapat di sebelah kanan window. 
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5.    Aturlah jarak obyek pertama dengan obyek kedua sedemikian rupa sehingga 
berjauhan. 

6. Klik tombol Interactive Blind Tool  yang terdapat pada tool box Special 

Effect. Arahkan pointer ke area halaman, maka pointer akan berubah menjadi 

 
7.    Arahkan pointer tersebut ke salah satu obyek sehingga pointer berubah seperti 

berikut . Click‐ 

drag dari obyek tersebut menuju obyek lainnya. 

 
Gambar 101. 

Efek blend 
 
 

8.    Klik Pick Tool lalu aktifkan obyek hasil blind/ transformasi obyek. Kita bisa 
mengubah efek blind 

dengan mengubah nilai‐nilai yang terdapat pada Property bar seperti gambar 
berikut: 

 
Property bar untuk efek Blind. 

 
 

9. Klik pada Number of Step  lalu masukkan angka 10. Perintah ini 

untuk mengurangi jumlah step blend. Anda juga bisa meng‐klik pada panah 

atas atau bawah yang terdapat disebelah kanannya untuk menambah atau 

mengurangi jumlah blend. 
 
 

10.  Klik obyek asli persegi panjang, lalu geserlah ke daerah lain. Anda perhatikan 

maka efek blend pada onyek tersebut akan mengikutinya. Demikian juga 

dengan penggeseran obyek asli segi lima. 

11.  Aktifkan kembali obyek dengan efek blend, lalu klik Clockwise Blend , 

perintah ini adalah untuk mengubah gradasi warna searah jarum jam (pada 

palette warna). 

12.  Klik  Counterclockwise  Blend   untuk  merubah  gradasi  warna  menjadi  
berlawanan  jarum  jam. 
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Untuk kembali ke warna semula, klik Direct Blend . 

13.  Anda  juga  bisa  mengatur  jarak  antar  obyek  blend  dengan  cara  klik  tombol  
object  and  Color 

Acceleration , lalu muncul pilihan seperti berikut: 

 
Gambar 103. Akselerasi 

obyek dan warna. 

14.  Geserlah slider pada accelerator object untuk mengatur jarak antar obyek. 

Geserlah slider pada color accelerator untuk mengubah akselerasi warna pada 

tiap‐tiap obyek. 

 
Akselerasi obyek dan warna. 

 
Effects – Contour 
Contour merupakan spesial efek untuk menghasilkan bentuk kontur objek 

1.    Buatlah sebuah obyek bujur sangkar menggunakan Rectangular Tool. 

2.    Beri warna sesuai selera anda melalui Color Palette di sebelah kanan Window. 

3.    Klik icon Interactive Effect tool lalu pilihlah Interactive Contour Tool . 

4.    Anda perhatikan pada Property bar akan muncul menu seperti berikut: 

 
Property Contour. 

 
 

1.    Berikan angka 5 pada Contour Step untuk menentukan jumlah kontur yang 
diinginkan. 

2.    Klik pada ikon Center , Inside , dan Outside  untuk menentukan orientasi 
kontur. 
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(a)Obyek Asli                     (b) Contour To Center         (c) Contour Inside                             
(d) Contour Outside 

 

 

 
Efek  Envelope 

1.    Buatlah obyek teks menggunakan Text Tool  lalu ketiklah “Desain Grafis”. 

2.    Perbesar ukuran teks tersebut kira‐kira 60 point. 

3. Klik ikon Interactive Envelope Tool  pada Tool Box. Anda perhatikan 

pada Property Bar akan muncul ikon‐ikon seperti berikut: 

 

 

 

 
 

Property Envelope. 
 
 

4.    Perintah ini digunakan untuk memanipulasi bentuk obyek. Proses manipulasi 
dilakukan pada node‐ 

node yang muncul pada obyek. 

5. Klik ikon Straight Line Mode  pada Property Bar, lalu klik drag pada salah 

satu node yang terdapat pada teks. Anda juga bisa menggunakan jenis 

envelope yang lain seperti Envelope Single Arc Mode, 
Envelope Double Arc Mode dan Envelope Unconstrained Mode dengan contoh hasil 
seperti berikut: 

 
 
 
 
 

(a) Envelope Straight Line Mode                                      (b) Envelope 
Single Arc Mode  

 

 
                                                                                              (c) Envelope Double Arc Mode                                   
(d) Envelope Unconstrained Mode 

 

Efek envelope. 

 

 

(a)   Anda bisa menambahkan atau mengurangi node dengan tool yang tersedia 

pada Property bar yaitu . Cara pemakaian tool‐tool tersebut 

sama sperti yang sudah dibahas pada bab sebelumnya tentang Editing Node. 
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(b)  Envelope Straight Line Mode menghasilkan perubahan bentuk obyek 

dengan mengikuti garis lurus. (c)   Envelope Single Arc Mode menghasilkan 

perubahan bentuk obyek melengkung. 

(d)  Envelope Double Arc Mode menghasilkan perubahan bentuk obyek 

melengkung, namun pada kedua sisi agak mendatar. 

(e)   Envelope Unconstrained Mode manghasilkan bentuk obek melengkung 

dengan disertai Control Point pada node yang digeser. Control point tersebut 

berfungsi untuk mengubah ke bentuk lain dengan lebih fleksibel (lengkungan 

tidak simetris). 

 
Efek Tiga Dimensi 

1.    Klik ikon Text Tool lalu ketik “LPKMA SUMEDANG”. 

2. Berilah warna pada teks tersebut sesuai selera anda. Berikan juga outline pada 

teks tersebut dengan cara klik kanan pada Color Palette. 

3.    Ubahlah jenis font menjadi Arial Black. Lalu perbesar ukuran font menjadi 30 point. 

4. Klik ikon Interactive Extrude Tool pada Tool Box. Anda perhatikan pada 

Property bar akan muncul ikon‐ikon seperti berikut: 

 
Gambar 119. Property 

bar Extrude. 
 
 

5. Klik pada Preset untuk memilih jenis efek tiga dimensi yang sudah tersedia 

secara default. Berikut ini adalah contoh hasil dari efek tiga dimensi yang 

tersedia pada Preset: 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

6. Klik pada Object Position, ubahlah angka yang terdapat pada sumbu X atau 

Y. perintah ini adalah untuk menggeser posisi obyek yang aktif ke posisi lain. 

7.    Buatlah teks yang baru “nama anda”, lalu perbesar ukuran teks tersebut. 

8. Aktifkan ikon Interactif Extrude Tool, lalu klik drag pada teks tersebut ke 

sembarang arah untuk membuat efek tiga dimensi. 
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9. Agar hasilnya lebih kelihatan bagus, klik kanan salah satu warna pada color 

palette untuk member warna pada outline teks. 

10.  perhatikan pada Property Bar, Klik pada Exturtion Type , maka muncul 
pilihan dibawahnya. 

 
 
 
 

  
 

11.  Pilihlah  salah  satu  dari  keenam  pilihan  tersebut,  lalu  lihat  hasilnya.  

Perintah  ini  adalah  untuk mengubah model ujung yang menuju View Piont. 

Berikut ini adalah contoh hasil editing obyek extrude menggunakan Extrution 

Type: 

  
 

12.  Aktifkan obyek extrude, lalu anda perhatikan maka akan muncul View Point. 

Geserlah View Point ke arah yang anda inginkan. 

  
 

13.  Aktifkan  salah  satu  obyek  extrude,  klik  pada  ikon  Depth  .  

Ubahlah  angka  yang  ada  di dalamnya misalnya 50. Perintah ini untuk 

mengubah kedalaman extrude yang diinginkan. 
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14.  Aktifkan salah satu  obyek extrude, lalu klik pada ikon Vanishing Point 

Coordinate . 

Perintah ini untuk mengubah posisi akhir koordinat ujung extrude. 

15.  Ubahlah angka yang terdapat pada sumbu X mupun sumbu Y. contoh hasil 

perubahannya seperti gambar berikut: 

 
 

16.  Aktifkan obyek extrude, lalu klik pada ikon Vanishing Point Properties

. Klik pada VP Locked To Page, perintah ini adalah untuk 

mengunci posisi ujung extrude pada halaman. jika obyek digeser kemanapun, 

maka ujung extrude tidak akan ikut bergeser. 

  
 

17.  Klik ikon Extrude Rotaion , anda perhatikan maka muncul flyout seperti 
berikut: 

 
 
 

  
 

18.  Arahkan  pointer  ke  lingkaran  tengah  yang  berisi  angka  “3”  lalu  klik‐drag  
sesuai  keinginan  anda. 

Perintah ini berfungsi untuk merotasikan obyek extrude. Namun perintah ini 

jarang digunakan karena hasilnya kurang bagus. 



 
Modul Desain Grafis Level III KKNI      77 
 

 
 

 
 

 
 

 
 

19.  Klik ikon color  pada property bar, sehingga muncul flyout seperti berikut: 
 
 
 
 
 
 
 
 
 
 
 
 

(a)                                        
(b)                                        
(c) 

 
 

20.  Gambar diatas menunjukkan 3 model pilihan untuk memberikan warna pada 

efek extrude. Secara  

 

 

standar (gambar (a)), warna yang digunakan adalah warna obyek, jika ingin 

mengubah warna extrude ke warna lain maka anda pilih pada mode warna ke 

dua atau ke tiga. 

21.  Klik pada Use Solid Color (gambar (b)), gantilah warna pada  dengan 
warna lain. 

22.  Klik   pada   Use   Color   Shading   (gambar   (c)),   gantilah   warna   pada   

  dan 
 

. Perintah ini adalah untuk membuat warna gradasi pada efek 
extrude. 

 
Gambar 129. Hasil perubahan warna 

menggunakan Color Extrude. 
 
 

23.  Klik ikon Bevels , maka akan muncul flyout sepert berikut: 

 
 

24.  Aktifkan   Check‐box   Use   Bevel   dan   ubahlah   Bevel   Depth   dan   Bevel   

Angle   sambil   melihat perubahannya. Berikut ini adalah contoh hasil efek 



 
Modul Desain Grafis Level III KKNI      78 
 

 
 

bevel: 

 
Contoh hasil efek bevel. 

 
 

25.  Klik pada ikon Lighting , maka muncul flyout seperti berikut: 

 
 

26.  Klik pada ikon lighting #1, lalu akan muncul lingkaran dengan angka satu di 
tengahnya. Geserlah kearah yang anda inginkan. Lakukan perintah yang sama 
untuk mencoba efek lighting yang lain. 

 

Catatan: 

Anda bisa memberikan semua efek lighting yang disediakan. 
 
 

27.  Klik ikon Copy Extrude Properties  , lalu pointer berubah menjadi anak panah         
. Klik pada efek 

extrude yang lain. Perintah ini untuk meng‐copy efek extrude ke efek extrude lain. 

28.  Klik ikon Clear Extrude  untuk menghilangkan/ menghapus efek extrude yang 
telah diberikan. 
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TUJUAN PEMBELAJARAN 

 

1. Peserta Didik Mampu menterjemahkan brief 

2. Peserta Didik Mampu Menciptakan Karya Desain Sesuai Brief 

3. Peserta Didik Mampu Menciptakan Karya Desain yang baik  

 

 

Menciptakan Karya Desain  

 

 

 

 

 

Karya desain merupakan Hasil pemikiran dari seorang desainer dalam menterjemahkan 

Brief sesuai dengan keinginan pelanggan. Karya yang dibuat dapat berupa Brosur, Logo, 

Flayer, Label, Majalah, Paper Bag Dll 

Buatlah sebuah karya sesuai dengan brief beriktu ini : 

1. SOAL PRAKTIK 1 

 

Desain Brief : 

Sebuah komunitas pecinta robot berencana untuk mengadakan sebuah acara pameran 

robot dengan tema : “Robot For Better Life”. Anggota komunitas ini terdiri dari berbagai 

kalangan masyarakat tua maupun muda yang senang akan teknologi terutama di bidang 

robotik. Rencana acara tersebut akan di gelar pada Tanggal 11-17 Januari 2025 

bertempat di Jakarta Convention Center. Acara yang akan digelar dalam pameran 

tersebut diantaranya : Workshop, Robot Competition, pertunjukan robot. Untuk 

informasi Pameran dan Lomba dapat menghubungi panitia di sekretariat Jln. Jenderal 

Soedirman No 56 Telp : 0221-2546. 

 

Tugas I Persiapan 

1. Buatlah Sebuah Folder di desktop dengan nama : “UJKGD-Nama Lengkap” 
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2. Didalam folder tersebut Buat dua folder dengan nama masing-masing : “LOGO” & 

“POSTER” 

3. Didalam Folder Logo dan Poster buat kembali masing-masing 2 folder dengan nama : 

“Mentahan” & “Hasil”. 

Tugas II Duplikasi Logo 

1. Buatlah ulang logo komunitas pecinta robot dengan ketentuan logo sebagai berikut : 

 

 

  

 

 

 

 

 

 

 

 

2. Menyimpan file mentahan di folder LOGO : dengan nama “Logo Komunitas” 

3. Export logo kedalam bentuk JPG & PDF dengan nama: “Logo Komunitas” dan simpan 

di Folder LOGO : “Hasil” 

 

Tugas III Pembuatan Logo 

1. Buatlah Desain Logo Pameran Robot dengan tema “Robot For Better Life” 

2. Desain menggunakan maksimal 3 warna tanpa gradasi 

3. Menyertakan informasi warna  & Font yang digunakan pada hasil desain logo 

4. Menyimpan file mentahan di folder LOGO : “Mentahan” 

5. Export logo kedalam bentuk JPG & PDF dengan nama: “Logo Pameran” dan simpan 

di Folder LOGO : “Hasil” 

Tugas IV Pembuatan Poster 

1. Buatlah desain Poster yang berisi informasi mengenai pameran robot dengan data 

sebagai berikut : 

2. Judul Pameran : “Robot For Better Life”  

Warna : Black ( C :0 M:0  Y:0 K:100 ) 

Font : Arial Black 
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Waktu : 11 – 27 Januari 2025 

Tempat : Jakarta Convention Center 

Acara : Workshop, Kompetisi Robot, Pertunjukan robot. 

Contact: Panitia Pameran Robot 

Jln. Jenderal Soedirman No 56 Telp : 022-2546788. 

3. Terapkan prinsip-prinsip dasar desain dalam pembuatan poster sehingga poster 

terlihat menarik dan mudah untuk dibaca 

4. Simpan file mentahan di Folder Poster : “Mentahan” 

5. Export Poster kedalam bentuk JPG & PDF dengan sudah diberi Bleed dan simpan di 

folder Poster : “Hasil” 

6. Tempatkan Logo Komunitas dan Logo Pameran yang telah dibuat sebelumnya ke 

dalam Desain Poster yang telah kamu buat. 

7. Untuk gambar Robot dan Bacground dapat mengambil dari folder  yang telah 

disediakan di desktop dengan nama : BAHAN – UJKGD, bahan boleh digunakan 

semua atau hanya sebagian tergantung kebutuhan desain 

8. Selamat Bekerja  

 

 

 

 

Ilustrasi Bahan Yang Digunakan 

Pada Soal Praktek Pertama 
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2. SOAL PRAKTIK II 

 

Desain Briep : 

Dalam rangka ulang tahun Badan Perlindungan Satwa Liar Indonesia (BPSLI) yang ke 70, BPSLI 

menyelenggarakan Lomba Photografy dengan tema “ Ragam Satwa Liar Indonesia”. Lomba 

tersebut diselenggarakan atas kerjasama BPLSI dengan beberapa forum Photografy. Lomba 

tersebut diharapkan mampu membuka hati seluruh masyarakat indonesia untuk ikut serta 

menjaga dan melindungi satwa liar Indonesia yang merupakan salah satu kekayaan negeri ini. 

Dalam ulang tahunnya yang ketiga ini BPLSI berencana mengubah Logonya sesuai visi misi BPLSI 

yaitu: Melindungi dan melestarikan satwa liar di Indonesia. 

 

Tugas I Persiapan 

1. Buatlah Sebuah Folder di desktop dengan nama : “UJKGD-Nama Lengkap” 

2. Didalam folder tersebut Buat dua folder dengan nama masing-masing : “LOGO” & “POSTER” 

3. Didalam Folder Logo dan Poster buat kembali masing-masing 2 folder dengan nama : 

“Mentahan” & “Hasil”. 

Tugas II Duplikasi Logo 

6. Buat Ulang Logo Sponsor yang bekerjasama dengan BPLSI dalam mengadakan Lomba Photo 

logonya sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Menyimpan file mentahan di folder LOGO : “Mentahan” 

8. Export logo kedalam bentuk JPG & PDF dengan nama: “Sponsor 1”& “Sponsor 2” dan simpan 

di Folder LOGO : “Hasil” 

Tugas III Pembuatan Logo Baru 

1. Buatlah Desain Logo Badan Perlindungan Satwa Liar Indonesia ( BPSLI ) 

Logo Sponsor 2 

Logo Sponsor 1 

Font : 

Arial 

Candara 

Font : Avantgrade Bk BT 

Warna : 

Biru : R:2 G :148 B : 202 
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2. Desain menggunakan maksimal 3 warna tanpa gradasi 

3. Menyertakan informasi warna  & Font yang digunakan pada hasil desain logo 

4. Menyimpan file mentahan di folder LOGO : “Mentahan” 

5. Export logo kedalam bentuk JPG & PDF dengan nama: “Logo BPLSI” dan simpan di Folder 

LOGO : “Hasil” 

Tugas IV Pembuatan Poster Lomba 

9. Buatlah desain Poster yang berisi ajakan dan informasi mengenai Lomba Foto Nasional 

dalam rangka Ulang tahun BPLSI yang ke 70 dengan data sebagai berikut : 

10. Judul Poster : LOMBA FOTO NASIONAL 

Tema : “Ragam Satwa Liar Indonesia”  

Ketentuan Lomba : 

1. Peserta Umum kecuali Anggota BPLSI 

2. Photo dapat diambil dengan kamera digital maupun kamera handphone dengan Resolusi 

Minimal 5 Megapixel 

3. Objek Photo adalah Satwa Liar Indonesia 

4. Peserta diperbolehkan mengirimkan photo terbaiknya maksimal 3 Photo 

5. Photo dikirim dengan format .JPG ke alamat panitia_bplsi70@gmail.com beserta scan 

photocopy KTP 

6. Batas pengiriman karya adalah tanggal 1 Desember 2025 

7. Pengumunan Pemenang Akan di umumkan pada tanggal 20 Desember 2025 

Hadiah 

Juara I : Rp. 10.000.000,- 

Juara 2 : Rp. 7.500.000,- 

Juara 3 : Rp. 5.000.000 

Informasi lebih lanjut : 

WA Panitia Lomba : 0852112456 

11. Terapkan prinsip-prinsip dasar desain dalam pembuatan poster sehingga poster terlihat 

menarik dan mudah untuk dibaca 

12. Sisipkan Logo sponsor dan logo BPLSI yang telah dibuat sebelumnya kedalam Poster Lomba 

13. Simpan file mentahan di Folder Poster : “Mentahan” 

14. Export Logo kedalam bentuk JPG & PDF dengan sudah diberi Bleed dan simpan di folder 

Poster : “Hasil” dengan nama “ POSTER LOMBA” 

15. Untuk gambar yang berhubungan dengan poster dapat mengambil dari folder  yang telah 

disediakan di desktop dengan nama : BAHAN – UJKGD, bahan boleh digunakan semua atau 

hanya sebagian tergantung kebutuhan desain. 

16. Selamat Bekerja  

 

 

 

 

mailto:panitia_bplsi70@gmail.com
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Tujuan Pembelajaran 

1. Peserta Didik mengetahui apa itu final artwork 

2. Peserta didik mengetahui hal-hal yang harus diperhatikan dalam final artwork 

3. Peserta Didik Mampu membuat finishing akhir sebuah karya desain untuk siap 

dicetak 

 

 

Final Artwork 

 

 

 

 

FINAL ARTWORK (FA) adalah istilah untuk file desain akhir yang siap cetak/print. Ada 

beberapa poin penting yang harus diperhatikan dalam menyiapkan final artwork. Poin-poin 

ini sangat penting untuk menghindari kesalahan pada saat cetak yang kemungkinan 

berujung pada hasil produksi yang tidak memuaskan. 

Beberapa hal yang perlu diketahui dalam final artwork 

1. Bleed 

Bleed adalah daerah pinggir area gambar yang berfungsi mengantisipasi ketidak akuratan 

pada saat pemotongan (produksi akhir), baik pemotongan secara manual maupun 

menggunakan mesin. Bleed sangatlah penting guna menghindari ketidakrapian pada hasil 

desain. Penerapan fungsi ini biasa berlaku pada brosur, kartu nama, buku, majalah, poster, 

dsb. 

 

 

 

 

 

 

http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqjyUOb3I/AAAAAAAAEYA/sHyaJ9cg4hA/s1600/print-bleed.jpg
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2. Convert Font 

Font untuk final artwork harus dikonversi terlebih dahulu kedalam bentuk kurva. Hal ini 

untuk menghindari missing font atau font yang tidak dikenali. Apalagi untuk font-font yang 

tidak secara default ter-install di OS yang umum dipakai seperti Windows dan Mac.

 

3. Resolusi 

Sesuaikan resolusi dengan kebutuhan cetak. Standar resolusi yang baik adalah 300 dpi. Tapi 

buat pengecualian untuk cetakan yang berukuran besar seperti billboard. Untuk jenis 

Outdoor print seperti ini, resolusi yang baik adalah 72-150 dpi. 

 

4. Mode Warna 

Pastikan mode warna artwork sudah dikonversi ke CMYK dan bukan RGB. Karena, proses 

percetakan dan printing hanya mengenal mode CMYK, dan biasanya, mesin cetak/print akan 

http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqjsAokzI/AAAAAAAAEX4/po4ScfKyPTE/s1600/convert-font.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqE2873xI/AAAAAAAAEXw/S6_11eJBAio/s1600/resolusi+gambar.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqjsAokzI/AAAAAAAAEX4/po4ScfKyPTE/s1600/convert-font.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqE2873xI/AAAAAAAAEXw/S6_11eJBAio/s1600/resolusi+gambar.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqjsAokzI/AAAAAAAAEX4/po4ScfKyPTE/s1600/convert-font.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqE2873xI/AAAAAAAAEXw/S6_11eJBAio/s1600/resolusi+gambar.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqjsAokzI/AAAAAAAAEX4/po4ScfKyPTE/s1600/convert-font.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqE2873xI/AAAAAAAAEXw/S6_11eJBAio/s1600/resolusi+gambar.jpg
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otomatis mengkonversi mode warna RGB ke CMYK. Hal ini tentu akan berpengaruh kepada 

kualitas warna pada desain. Jadi, pastikan warna pada desain sesuai dengan yang diinginkan 

dalam mode warna CMYK. 

 

5. Crop Mark 

Crop Mark merupakan garis potong yang berfungsi sebagai panduan pada saat pemotongan. 

Crop Mark digunakan untuk memberi tahu bagian mana yang harus dipotong, dilipat, dsb. 

Beberapa aplikasi grafis telah menyediakan fungsi untuk membuat Crop Mark secara 

otomatis. 

 

 

 

 

 

6. Ukuran Artwork 

http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqEfxJKYI/AAAAAAAAEXo/L8W4yuFRi9A/s1600/CMYK+mode+warna+printing.png
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqD26mh9I/AAAAAAAAEXg/CTiQX0TSt7o/s1600/Corp-Mark-tanda-potong.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqEfxJKYI/AAAAAAAAEXo/L8W4yuFRi9A/s1600/CMYK+mode+warna+printing.png
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqD26mh9I/AAAAAAAAEXg/CTiQX0TSt7o/s1600/Corp-Mark-tanda-potong.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqEfxJKYI/AAAAAAAAEXo/L8W4yuFRi9A/s1600/CMYK+mode+warna+printing.png
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqD26mh9I/AAAAAAAAEXg/CTiQX0TSt7o/s1600/Corp-Mark-tanda-potong.jpg
http://3.bp.blogspot.com/_I_PFFJSrTec/TJYqEfxJKYI/AAAAAAAAEXo/L8W4yuFRi9A/s1600/CMYK+mode+warna+printing.png
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqD26mh9I/AAAAAAAAEXg/CTiQX0TSt7o/s1600/Corp-Mark-tanda-potong.jpg
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Pastikan ukuran file desain cetak kamu adalah ukuran sebenarnya (Actual Pixel). Tentu saja 

kita tidak ingin kualitas pixel gambar ngeblur akibat ukuran file artwork lebih kecil dari 

ukuran yang sebenarnya. 

 

7. Image link 

Beberapa aplikasi grafis seperti Adobe Illustrator secara default menampilkan gambar 

(image) dengan tautan link ke folder di komputer. Hal ini untuk menghemat kapasitas file 

artwork yang kita kerjakan. Apabila file berpindah komputer, maka gambar yang seharusnya 

tampil pada desain tidak bisa ditemukan. Prinsipnya sama seperti font, kita bisa 

menggunakan fungsi embed untuk memasukkan gambar secara utuh pada file. 

http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqDgqX4rI/AAAAAAAAEXY/iZYTB9McNxE/s1600/ukuran+gambar+actual+pixel.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqDgqX4rI/AAAAAAAAEXY/iZYTB9McNxE/s1600/ukuran+gambar+actual+pixel.jpg
http://2.bp.blogspot.com/_I_PFFJSrTec/TJYqDgqX4rI/AAAAAAAAEXY/iZYTB9McNxE/s1600/ukuran+gambar+actual+pixel.jpg
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http://4.bp.blogspot.com/_I_PFFJSrTec/TJYqDNq_Y5I/AAAAAAAAEXQ/7fSYIYJvRp0/s1600/link-gambar.jpg
http://4.bp.blogspot.com/_I_PFFJSrTec/TJYqDNq_Y5I/AAAAAAAAEXQ/7fSYIYJvRp0/s1600/link-gambar.jpg
http://4.bp.blogspot.com/_I_PFFJSrTec/TJYqDNq_Y5I/AAAAAAAAEXQ/7fSYIYJvRp0/s1600/link-gambar.jpg
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